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Welcome to OnCommand Insight reporting
The OnCommand Insight Reporting Connection is a business intelligence tool that enables you to
view pre-defined reports or create your own custom reports. The OnCommand Insight Reporting
Connection generates the reports from the Data Warehouse (DWH) data.
You can do the following tasks using OnCommand Insight Reporting Connection:
•

Run a report.

•

Create your own custom report.

•

Customize the report format and delivery method.

•

Schedule reports to run.

•

Email reports.

•

Use colors to represent thresholds on data.

•

Access a collection of report results on a dashboard.

•

Add tabs to views to show a dashboard collection of report results.

The pre-defined Inventory reports are the standard OnCommand Insight reports. Additional predefined reports are provided with the Assure, Perform, and Plan licenses. This guide describes the
pre-defined reports available with all of the product licenses.
Note: The OnCommand Insight data can be viewed in any standard browser. However, the report
generation engine requires the Microsoft Windows Internet Explorer (IE) browser. Reports cannot
be dependably generated when using other web browsers.

Using predefined reports to answer common questions
OnCommand Insight includes predefined reports that address a number of common reporting
requirements providing critical insight that stakeholders need to make informed decisions about their
storage infrastructure.
The following predefined reports are available in Public folders > Reports.
Application Service Level Capacity and Performance
Provides an overview of storage utilization by application.
Chargeback
Provides storage capacity chargeback and accountability information by hosts,
application, and business entities, and includes both current and historical data.
ESX vs VM Performance
Provides a comparison of ESX and VM performance.
Fabric Summary
Reports where a specific device is connected, and identifies free switch ports.
Host HBAs
Provides an overview of the hosts in the environment including the vendor, model, and
firmware version of HBAs, and the firmware level of the switches to which they are
connected.
Host Service Level Capacity and Performance
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Provides an overview of storage utilization by host.
Host Summary
Provides an overview of storage utilization by each selected host with information for
Fibre Channel and iSCSI hosts.
Mapped but not Masked Volumes
Lists the volumes whose logical unit number (LUN) has been mapped for use by a
particular host, but is not masked to that host. Unmasked volumes can be accessed by any
host, making them vulnerable to data corruption.
NetApp Capacity and Performance
Provides allocated, utilized, and committed capacity trending and performance data for
NetApp capacity.
OCI Scorecard
Provides a summary and general status of all assets discovered by OnCommand Insight.
Storage Summary
Provides used and unused capacity data on raw, storage pool, volume, and allocated
storage.
VM Capacity and Performance
Describes the virtual machine (VM) environment and its capacity usage.
VM Paths
Provides data store capacity data and performance metrics.
Related concepts

Inventory reports on page 32
Capacity and chargeback dashboards and reports on page 40

Locating predefined reports
The predefined OnCommand Insight reports can be accessed from different locations in the
OnCommand Insight Reporting Portal.
A report can be part of a dashboard and can also be generated from a list of individual reports. There
can be several locations in the portal for a single report. The multiple access points for reports are a
result of OnCommand Insight customer requests for report groupings to help them with different
types of analysis.
This guide lists the shortest paths to locate individual reports.
•

Public Folders > Reports

•

Public Folders > Packages

•

Public Folders > Storage Manager Dashboard

•

Public Folders > Vendoc Specific Reports

The documentation lists only the shorter path to help you to find the report quickly. If an individual
report is generated on a dashboard, that information is also provided.
While using the reports, you can group your favorite dashboards and reports together into your own
folder in the portal.
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Variations due to installed licenses
Data in the OnCommand Insight reports is based upon the OnCommand Insight licenses that you
have purchased. For example, if you do not have OnCommand Insight Plan installed, then you will
not receive any data in the capacity reports.
You might see differences between the available reports in your OnCommand Insight windows
compared to the illustrations in the documentation. These variations are due to differences between
the installed licenses on your system and the licenses on the system used to create the illustrations.

OnCommand Insight licenses
OnCommand Insight operates with licenses that enable specific features on the Insight Server.
Discover
Discover is the basic Insight license that supports inventory. You must have a Discover
license to use OnCommand Insight, and the Discover license must be paired with at least
one of the Assure, Perform, or Plan licenses.
Assure
An Assure license provides support for assurance functionality, including global and SAN
path policy, and violation management. An Assure license also enables you to view and
manage vulnerabilities.
Perform
A Perform license supports performance monitoring on asset pages, dashboard widgets,
queries, and so on, as well as managing performance policies and violations.
Plan
A Plan license supports planning functions, including resource usage and allocation.
Host Utilization pack
A Host Utilization license supports file system utilization on hosts and virtual machines.
Report Authoring
A Report Authoring license supports additional authors for reporting. This license requires
the Plan license.
OnCommand Insight modules are licensed for annual term or perpetual:
•

By terabyte of monitored capacity for Discover, Assure, Plan, Perform modules

•

By number of hosts for Host Utilization pack

•

By number of additional units of Cognos pro-authors required for Report Authoring

License keys are a set of unique strings that are generated for each customer. You can obtain license
keys from your OnCommand Insight representative.
Your installed licenses control the following options that are available in the software:
Discover
Acquire and manage inventory (Foundation)
Monitor changes and manage inventory policies
Assure
View and manage SAN path policies and violations
View and manage vulnerabilities
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View and manage tasks and migrations
Plan
View and manage requests
View and manage pending tasks
View and manage reservation violations
View and manage port balance violations
Perform
Monitor performance data, including data in dashboard widgets, asset pages, and queries
View and manage performance policies and violations
The following tables provide details of the features that are available with and without the Perform
license for admin users and non-admin users.
Feature (admin)

With Perform license

Without Perform license

Application

Yes

No performance data or charts;
no anomaly detection-related
widgets

Virtual machine

Yes

No performance data or charts

Hypervisor

Yes

No performance data or charts

Host

Yes

No performance data or charts

Datastore

Yes

No performance data or charts

VMDK

Yes

No performance data or charts

Internal volume

Yes

No performance data or charts

Volume

Yes

No performance data or charts

Storage pool

Yes

No performance data or charts

Disk

Yes

No performance data or charts

Storage

Yes

No performance data or charts

Storage node

Yes

No performance data or charts

Fabric

Yes

No performance data or charts

Switch port

Yes

No performance data or charts;
“Port Errors” shows “N/A”

Storage port

Yes

Yes

NPV port

Yes

No performance data or charts

Switch

Yes

No performance data or charts

NPV switch

Yes

No performance data or charts

Search

Yes

Yes

Admin

Yes

Yes

Dashboard

Yes

Yes

Widgets

Yes

Partially available (only asset,
query, and admin widgets are
available)
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Feature (admin)

With Perform license

Without Perform license

Violations dashboard

Yes

Hidden

Assets dashboard

Yes

Partially available (storage
IOPS and VM IOPS widgets
are hidden)

Manage performance policies

Yes

Hidden

Manage annotations

Yes

Yes

Manage annotation rules

Yes

Yes

Manage applications

Yes

Yes

Queries

Yes

Yes

Manage business entities

Yes

Yes

Feature

User - with
Perform license

Guest - with
Perform license

User - without
Perform license

Guest - without
Perform license

Assets dashboard

Yes

Yes

Partially available
(storage IOPs and
VM IOPs
widgets are
hidden)

Partially available
(storage IOPs and
VM IOPs
widgets are
hidden)

Custom
dashboard

View only (no
create, edit, or
save options)

View only (no
create, edit, or
save options)

View only (no
create, edit, or
save options)

View only (no
create, edit, or
save options)

Manage
performance
policies

Yes

Hidden

Hidden

Hidden

Manage
annotations

Yes

Hidden

Yes

Hidden

Manage
applications

Yes

Hidden

Yes

Hidden

Manage business
entities

Yes

Hidden

Yes

Hidden

Queries

Yes

View and edit
only (no save
option)

Yes

View and edit
only (no save
option)

In some cases, you can also install a Replication Assurance license, which enables you to collect
disaster recovery (DR) information. DR information can be monitored in the Java UI in the following
views:
•

Inventory > DR Paths

•

Inventory > Replications Dashboard

•

Assurance > DR Rules

•

Assurance > DR Violations
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Reporting user roles
Each user account is assigned a role with a set of permissions. The number of users is limited by the
number of Reporting licenses attached to each role.
Each role can perform the following actions:
Recipient
Views OnCommand Insight Reporting portal dashboards and reports and sets personal
preferences such as those for languages and time zones.
Note: Recipients cannot create reports, run reports, schedule reports, export reports, nor

perform administrative tasks.
Business Consumer
Runs reports in Workspace and runs reports interactively in addition to performing all
Recipient options.
Business Author
Views scheduled reports, runs reports interactively, and creates some reports in addition to
performing all Business Consumer options.
Pro Author
Creates reports in addition to performing all Business Author options and has advanced
reporting tool options that are available also with Report Studio.
Administrator
Performs reporting administrative tasks such as the import and export of report definitions,
configuration of reports, configuration of data sources, and the shutdown and restart of
reporting tasks.
The following table shows the privileges and the maximum number of users allowed for each role:
Feature

Recipient

Business
Consumer

Business
Author
(Insight
Plan only)

Pro Author
(Insight Plan
only)

Admin

View reports in the
Public Folders and
My Folders tabs

Yes

Yes

Yes

Yes

Yes

Run reports

No

Yes

Yes

Yes

Yes

Schedule reports

No

Yes

Yes

Yes

Yes

Create reports in
Query Studio

No

No

Yes

Yes

No

Create reports in
Workspace

No

Yes

Yes

Yes

No

Create reports in
Workspace
Advanced

No

No

Yes

Yes

No

Create reports in
Report Studio

No

No

No

Yes

No

Perform
administrative tasks

No

No

No

No

Yes
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Feature

Recipient

Business
Consumer

Business
Author
(Insight
Plan only)

Pro Author
(Insight Plan
only)

Admin

Number of users

Number of
OnCommand
Insight users

20

2

1

1

When you add a new Data Warehouse and Reporting user, if you exceed the limit in a role, the user is
added as “deactivated,” and you need to deactivate or remove another user with that role to give a
new user membership.
Note: Report authoring capabilities require Insight Plan license. You can add additional Business
Author and Pro Author users by purchasing the ARAP (Additional Report Authoring Package).
Contact your OnCommand Insight representative for assistance.

These reporting user roles do not affect direct database access. These reporting user roles do not
impact your ability to create SQL queries using the data marts.

OnCommand Insight Reporting Portal installation
The Insight Reporting Portal requires the installation of other components to work as designed.
The following environment is necessary to provide optimum use of the OnCommand Insight
Reporting data model:
•

The current version of OnCommand Insight

•

The current version of OnCommand Insight Data Warehouse

See the following resources for additional information:
•

For installation instructions for the OnCommand Insight Reporting Portal, see the OnCommand
Insight Installation Guide for Microsoft Windows or the OnCommand Insight Installation Guide
for Red Hat Enterprise Linux.

•

For more information about Cognos features, see the Cognos documentation.

OnCommand Insight data models
OnCommand Insight includes several data models from which you can either select predefined
reports or create your own custom report.
Capacity data model
Enables you to answer questions about storage capacity, file system utilization, internal
volume capacity, port capacity, qtree capacity, and virtual machine (VM) capacity. The
Capacity data model is a container for several capacity data models.
Storage and Storage Pool Capacity data model
Enables you to answer questions about storage capacity resource planning, including
storage and storage pools, and includes both physical and virtual storage pool data.
This simple data model can help you answer questions related to capacity on the
floor and the capacity usage of storage pools by tier and data center over time.
If you are new to capacity reporting, you should start with this data model because it
is a simpler, targeted data model.
File System Utilization data model
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Enables you to answer questions about file system utilization. This data model
provides visibility about capacity utilization by hosts at the file system level.
Administrators can determine allocated and used capacity per file system, determine
the type of file system, and identify trending statistics by file system type.
Internal Volume Capacity data model
Enables you to answer questions about internal volume used capacity, allocated
capacity, and capacity usage over time.
Port Capacity data model
Enables you to answer questions about switch port connectivity, port status, and
speed over time. This data can be used when planning for the purchase of new SAN
switches.
Qtree Capacity data model
Enables you to trend qtree utilization (with data such as used versus allocated
capacity) over time. You can view the information by different dimensions—for
example, by business entity, application, tier, and service level.
VM Capacity data model
Enables you to report your x (VM) environment and its capacity usage. This data
model lets you report on changes in capacity usage over time for VMs and data
stores. The data model also provides thin provisioning and virtual machine
chargeback data.
Volume Capacity data model
Enables you to analyze all aspects of the volumes in your environment and view them
by vendor, model, tier, service level, and data center. You can view the capacity
related to orphan volumes, unused volumes, and protection volumes (used for
replication). You can also see different volume technologies (iSCSI or FC), and
compare virtual volumes to non-virtual volumes for array virtualization issues.
Chargeback data model
Enables you to answer questions about used capacity and allocated capacity on storage
resources (volumes, internal volumes, and qtrees). This data model provides storage
capacity chargeback and accountability information by hosts, application, and business
entities, and includes both current and historical data. Report data can be categorized by
service level and storage tier.
You can use this data model to generate chargeback reports by finding the amount of
capacity that is used by a business entity. This data model enables you to create unified
reporting of multiple protocols (including NAS, SAN, FC, and iSCSI).
Inventory data model
Enables you to answer questions about inventory resources such as hosts, storage systems,
switches, disks, tapes, qtrees, quotas, virtual machines and servers, and generic devices.
The Inventory data model includes several submarts that enable you to view information
about replications, FC paths, iSCSI paths, NFS paths, and violations. The Inventory data
model does not include historical data.
Performance data model
Enables you to answer questions about performance for volumes, application volumes,
internal volumes, switches, applications, VMs, VMDKs, ESX versus VM, hosts, and
application nodes.
The Performance data model includes information that helps you determine the
appropriateness of tiers, storage misconfigurations for applications, and last access times
of volumes and internal volumes. This data model provides data such as response times,
IOPs, throughput, number of writes pending, and accessed status.
Storage Efficiency data model
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Enables you to track the storage efficiency score and potential over time. This data model
stores measurements of not only the provisioned capacity, but also the amount that is used
or consumed (the physical measurement). For example, when thin provisioning is enabled,
OnCommand Insight indicates how much capacity is taken from the device. You can also
use this model to determine efficiency when deduplication is enabled.

Accessing the Data Warehouse portal
The OnCommand Insight Data Warehouse portal is a web-based user interface that you can use to
update connector information, view job queues, schedule daily builds, select annotations, set up email
notifications, view system information, build the database, reset Data Warehouse, back up and restore
the database, troubleshoot issues, manage Data Warehouse and Reporting portal user accounts, and
access documentation and schema diagrams.
About this task

The following is the default user name and password. It is a good idea to change these defaults after
installation.
•

User name: admin

•

Password: admin123

Steps

1. Log in to the Data Warehouse portal at https://hostname/dwh, where hostname is the name
of the system where OnCommand Insight Data Warehouse is installed.
2. Enter your user name and password.
3. Click Login.
The Data Warehouse portal opens:
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Data Warehouse software components
OnCommand Insight Data Warehouse includes several software components.
•

MySQL database
The back-end repository for data mart tables

•

IBM Cognos
The reporting engine for OnCommand Insight

•

Apache Derby Database
Used for storing Cognos configuration and content

•

JBoss
The Java Enterprise application server that hosts OnCommand Insight components

What the Storage Manager Dashboard enables you to do
You can use the Storage Manager Dashboard for the daily management of your storage services.
The Storage Manager Dashboard provides you with a centralized visualization that enables you to
compare and contrast resource usage over time against the acceptable ranges and previous days of
activity. Showing only the key performance metrics for your storage services, you can make
decisions about how to grow and maintain your data centers.
The dashboard comprises seven components that contain contextual information on certain aspects of
your storage environment. You can drill down on the aspects of your storage services to perform an
in-depth of analysis of a section that interests you most.

Summary
This component shows the used versus usable storage capacity, total switch ports versus the number
of switch ports connected, and total connected switch port utilization versus the total bandwidth, and
how each of these trend over time. You can view the actual utilization compared against the low, mid,
and high ranges, which enables you to compare and contrast usage between Insight projections and
your desired actuals, based on a target. For capacity and switch ports, you can configure this target.
The forecast is based on an extrapolation of the current growth rate and the date you set. When the
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forecasted used capacity, which is based on future usage projection date, exceeds the target, an alert
(solid red circle) appears next to Capacity.
Storage Tiers Capacity
This component shows the tier capacity used versus the capacity allocated to the tier, which indicates
how the used capacity increases or decreases over a 12-month period and how many months are
remaining to full capacity. Capacity usage is shown with values provided for actual usage, the usage
forecast by Insight, and a target for capacity, which you can configure. When the forecasted used
capacity, which is based on future usage projection date, exceeds the target capacity, an alert (solid
red circle) appears next to a tier.
You can click any tier to display the Storage Pools Capacity and Performance Details report, which
shows free versus used capacities, number of days to full, and performance (IOPS and Response
Time) details for all the pools in the selected tier. You can also click any storage or storage pool name
in this report to display the asset page summarizing the current state of that resource.
Daily Storage Traffic
This component shows how the environment is performing compared to normal when there is any
large growth, changes, or potential issues in the previous six months. It also shows the average traffic
versus the traffic for the previous seven days, and for yesterday. You can visualize any abnormalities
in the way the infrastructure is performing because it provides information that highlights both
cyclical (previous seven days) and seasonal variations (previous six months).
You can click the title (Daily Storage Traffic) to display the Storage Traffic Details report, which
shows the heat map of the hourly storage traffic for the previous day for each storage system. Click
any storage name in this report to display the asset page summarizing the current state of that
resource.
Data Centers Time to Full
This component shows all the data centers versus all of the tiers and how much capacity remains in
each data center for each tier of storage based on Insight forecasted growth rates. Tier capacity level
is shown in blue; the darker the color, the lesser time the tier at the location has left before it is full.
You can click a section of a tier to display the Storage Pools Days to Full Details report, which shows
total capacity, free capacity, and number of days to full for all the pools in the selected tier and the
data center. Click any storage or storage pool name in this report to display the asset page
summarizing the current state of that resource.
Top 10 Applications
This component shows the top 10 applications based on the used capacity. Regardless of how the tier
organizes the data, this area displays the current used capacity and share of the infrastructure. You
can visualize the range of user experience for the previous seven days to see if consumers experience
acceptable (or, more importantly, unacceptable) response times.
This area also shows trending, which indicates if the applications meet their performance service
level objectives (SLO). You can view the previous week's minimum response time, the first quartile,
the third quartile, and the maximum response time, with a median shown against an acceptable SLO,
which you can configure. When the median response time for any application is out of the acceptable
SLO range, an alert (solid red circle) appears next to the application. You can click an application to
display the asset page summarizing the current state of that resource.
Storage Tiers Daily Performance
This component shows a summary of the tier's performance for response time and IOPS for the
previous seven days. This performance is compared against a SLO, which you can configure,
enabling you to see if there is opportunity to consolidate tiers, realign workloads delivered from those
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tiers, or identify issues with particular tiers. When median response time or median IOPS is out of the
acceptable SLO range, an alert (solid red circle) appears next to a tier.
You can click a tier name to display the Storage Pools Capacity and Performance Details report,
which shows free versus used capacities, number of days to full, and performance (IOPS and
response time) details for all the pools in the selected tier. Click any storage or storage pool in this
report to display the asset page summarizing the current state of that resource.
Orphaned Capacity
This component shows the total orphaned capacity and orphaned capacity by tier, comparing it
against acceptable ranges for total usable capacity and showing the actual capacity that is orphaned.
Orphaned capacity is defined by configuration and by performance. Storage orphaned by
configuration describes a situation in which there is storage allocated to a host. However, the
configuration has not been performed properly and the host cannot access the storage. Orphaned by
performance is when the storage is correctly configured to be accessed by a host. However, there has
been no storage traffic.
The horizontal stacked bar shows the acceptable ranges. The darker the gray, the more unacceptable
the situation is. The actual situation is shown with the narrow bronze bar that shows the actual
capacity that is orphaned.
You can click a tier to display the Orphaned Storage Details report, which shows all the volumes
identified as orphaned by configuration and performance for the selected tier. Click any storage,
storage pool, or volume in this report to display the asset page summarizing the current state of that
resource.
Changing Storage Manager Dashboard settings
You can configure target values for capacity based on future usage projection dates and ranges for
service level objectives (SLO) for some of the Storage Manager Dashboard components. For
example, you can configure the Summary to show the target and forecast for the end of the financial
year so that you can track how you are growing capacity compared with the forecast; this enables you
to adjust trajectories and budget allocation.
Steps

1. Open Insight in your browser.
2. Enter the following URL:
http://server-name/9300/p2pd/servlet/dispatch
9300 represents the default port specified during installation. If another port was specified, you

need to change the port.
3. In the login window, enter your user name and password, and then click Login.
The Storage Manager Dashboard is displayed in the Insight Reporting window.
4. In the Public Folder list, click the Set properties icon to the far right of the Storage Manager
Report folder.
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5. Click the Report tab.
6. Click Edit.
The Storage Manager Dashboard Settings page is displaysed

7. For Summary, you can do the following:
•

In Enter Target for Capacity in PB, enter a target for capacity in petabytes, and then select a
date from the Select future usage projection date list to specify the projected time period in
which capacity should not exceed the target.
In the example page shown above, an alert (solid red circle) appears next to Capacity in the
Summary section of the Storage Manager Dashboard window when storage capacity exceeds
1 petabyte before January 1, 2015.

•

In Enter Target for FC Switch Ports in %, enter a target percentage for the number of
switch ports connected, which Insight compares against the total number of switch ports.

8. For Storage Tiers Capacity, enter a target percentage in Enter Target for Capacity in % for
storage tier capacity.
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Insight uses the date in the Select future usage projection date list as the projected time period
in which storage tier capacity should not exceed the target.
In the example page shown above, an alert (solid red circle) appears next to the storage tier in the
Storage Tiers Capacity section of the Storage Manager Dashboard window when the used
capacity of a storage tier exceeds 80% of the usable capacity before January 1, 2015.
9. For Top 10 Applications, enter a value in SLO Start and in SLO End to create a range for
acceptable response times.
In the example page shown above, an alert (solid red circle) appears next to the application in the
Top 10 Applications section of the Storage Manager Dashboard window when the median
response time is greater than 100 milliseconds
10. For Storage Tiers Daily Performance, you can do the following:
•

Enter a value in SLO Start and in SLO End to create a range for acceptable response times.

•

Enter a value in SLO Start and in SLO End to create a range for acceptable input/output
operations per second (IOPS).

In the example page shown above, an alert (solid red circle) appears next to the storage tier in
theStorage Tiers Daily Performance section of the Storage Manager Dashboard window when the
median response time of a storage tier is greater than 500 milliseconds or the median IOPS is
greater than 2000 seconds.
11. Click Finish.
12. To make the changes take effect immediately:
a. Go to the Public Folders list in the Reporting Portal.
b. Click the Storage Manager Dashboard folder.
c. Click the Run with options

icon to the far right of the Storage Manager Report folder.

d. Click Save the report.
e. Click Run.
Alternatively, you can wait until the Extract, Transform, and Load (ETL) process runs, which also
applies any changes.

Data Warehouse processes
Data Warehouse performs many types of processes.
ETL process
The Extract Transform and Load (ETL) process retrieves data from multiple OnCommand
Insight databases, transforms the data, and saves it into the data mart. The Data Warehouse
build process is an ETL process.
Jobs
Data Warehouse performs and reports on jobs such as these: inventory, dimensions,
capacity, port capacity, VM capacity, file system utilization, performance, capacity
efficiency, licenses, history build, dynamic annotations, connector removal, skipped build,
AutoSupport option, and maintenance jobs.
Consolidation process
Data Warehouse supports the consolidation of multiple OnCommand Insight servers into
the same Data Warehouse database. In many configurations it might happen that the same
object is reported from multiple connectors (that is, the same switch exists in two
OnCommand Insight instances). In that case, Data Warehouse consolidates the multiple
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objects into one (a primary connector is chosen and the object’s data is taken from that
connector only).

How Data Warehouse extracts data
The Extract, Transform, and Load (ETL) process retrieves data from multiple OnCommand Insight
databases, transforms the data, and saves it into the data marts.
OnCommand Insight connectors invoke a series of batch jobs to extract data from multiple
OnCommand Insight mySQL databases and publish the data in various data marts, as shown in the
following diagram.

The ETL process includes these individual processes:
Extract
This process takes data from multiple OnCommand Insight databases, transforms the data,
and saves it into the data mart. The process is performed against each OnCommand
Insight instance at the same time. To ensure that data cleansing and deduplication is
performed, it is not possible to split the ETL process into multiple scheduled ETL
operations.
Transform
This process applies business logic rules or functions to extract the data from the
OnCommand Insight database.
Load
This process loads the transformed data into public data marts.
ETL frequency and date data
You should run the Extract, Transform, and Load (ETL) process at least once per day; however, you
choose to run ETL numerous times if needed.
By default, the Cognos reporting engine treats all capacity and performance facts as additive. As a
result, there is a risk of double counting capacity data if the ETL process is run multiple times per
day without the proper time filters.
Two date data elements in the Date dimension are related to the daily ETL process. The Date
dimension, which is used in several data models, includes the following data elements that are
affected by the ETL:
Is Day Representative
The "Is Day Representative" data element is set to a value of 1 (true) during the first ETL
process run during any given day. If the first ETL process is run at 1:00 a.m., Is Day
Representative is set to 1 for all of the data loaded during the 1:00 a.m. ETL process. If a
second ETL is scheduled later (for example, 1:00 p.m.), Is Day Representative is set to 0
(false) for the data loaded during that ETL process.
Is Latest
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The "Is Latest" member is set to a value of 1 (true) after each ETL process completes. If
the first ETL process is run at 1:00 a.m., Is Latest is set to 1 for all of the data loaded
during the 1:00 a.m. ETL process. If another ETL process is scheduled later (for example,
1:00 p.m.), Is Latest is set to 1 for data loaded during the 1 p.m. ETL process. The ETL
process also sets the 1:00 a.m. ETL load's Is Latest entry to 0 (false).
How historical data is retained in Data Warehouse
Data is maintained in Data Warehouse according to a schedule.
Data Warehouse retains historical data based on the data marts and granularity of the data, as shown
in the following summary:
Data mart

Measured object

Granularity

Retention period

Performance marts

Volumes and internal
volumes

Hourly

14 days

Performance marts

Volumes and internal
volumes

Daily

13 months

Performance marts

Application

Hourly

13 months

Performance marts

Host

Hourly

13 months

Performance marts

Switch performance
for port

Hourly

5 weeks

Performance marts

Switch performance
for host, storage and
tape

Hourly

13 months

Performance marts

Storage node

Hourly

14 days

Performance marts

Storage node

Daily

13 months

Capacity marts

All (except individual
volumes)

Daily

13 months

Capacity marts

All (except individual
volumes)

Monthly
representative

14 months and beyond

Inventory mart

Individual volumes

Current state

1 day (or until next
ETL)

After 13 months, which is configurable, Data Warehouse retains only one record per month instead of
one record per day for capacity, performance, and resource data in the following tables:
•

Chargeback fact table (dwh_capacity.chargeback_fact)

•

File System Utilization fact table (dwh_fs_util.fs_util_fact)

•

Host fact table (dwh_sa.sa_host_fact)

•

Internal Volume Capacity fact table (dwh_capacity.internal_volume_capacity_fact)

•

Ports fact table (dwh_ports.ports_fact)

•

Qtree Capacity fact table (dwh_capacity.qtree_capacity_fact)

•

Storage and Storage Pool Capacity fact table
(dwh_capacity.storage_and_storage_pool_capacity_fact)

•

Volume capacity fact table (dwh_capacity.vm_capacity_fact)
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•

Storage Node Hourly Performance (storage_node_hourly_performance_fact) and Storage Node
Daily Performance (storage_node_daily_performance_fact) fact tables

Data retention, ETL, and time periods
OnCommand Insight Data Warehouse retains data obtained from the Extract, Transform, and Load
(ETL) process for different time periods based on the different data marts and time granularity of the
data.
Performance Marts and hourly granularity for volumes and internal volumes
The OnCommand Insight Data Warehouse records the hourly averages, hourly maximums, and
access bit for each hour of the day (24 data points) for 14 days. The access bit is a Boolean value that
is true if the volume is accessed or false if the volume is not accessed during the hourly interval. All
24 data points for the preceding day are obtained during the first ETL process of the day.
You do not need to run one ETL process per hour to gather the hourly data points. Running additional
ETL processes during the day does not obtain any performance information from the OnCommand
Insight Servers.
Performance Marts and daily granularity for volumes and internal volumes
Each day when the ETL is processed, the daily averages for the preceding day are calculated and
populated within Data Warehouse. The daily average is a summary of the 24 data points for the
previous day. The performance data marts retain daily summaries for volumes and internal volumes
for 13 months.
Capacity marts and daily granularity
The Capacity marts provide daily measurements for various capacity facts on a daily basis for a
period of 13 months. The capacity facts in Data Warehouse are current as of the last data source
acquisition for the device prior to the ETL.
Capacity marts and monthly granularity
Data Warehouse retains daily capacity data for 13 months. After the 13-month threshold is reached,
the capacity data is summarized on a monthly basis. The monthly data is based on the values
reflected by the date that is the month representative date.
The following table shows which monthly data is included in the monthly summary:
Date

Is Month Representative
value

Allocated capacity

Jan 1

1 (True)

50 TB

Jan 2

0 (False)

52 TB

...

...

...

Jan 31

0 (False)

65 TB

Feb 1

1 (True)

65 TB

Based on the table, a monthly report would show 50 TB allocated for January and 65 TB allocated
for February. All of the other capacity values for January would not be included in the monthly
summary.
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Inventory mart
The Inventory data mart is not historical. Each time an ETL process is run, the Inventory mart is
erased and rebuilt. Therefore, any reports generated out of the Inventory mart do not reflect historical
inventory configuration.

Where to find more information about OnCommand Insight
You can find more information about OnCommand Insight on the NetApp Support Site and in other
OnCommand Insight documentation.

Accessing OnCommand Insight Reporting Connection Help
You can find descriptions of predefined reports, instructions on how to create custom reports, and
descriptions of data models in the Help for OnCommand Insight Reporting Connection.
Choices

•

From the Data Warehouse Help menu, select Reporting Help.

•

Use a browser:
https://<server_name>:9300/p2pd/servlet/dispatch

OnCommand Insight on the web
For comprehensive, up-to-date information about OnCommand Insight, use these NetApp web site
resources.
•

OnCommand Insight product web site at
www.netapp.com/oncommandinsight

•

The NetApp Support Site at: mysupport.netapp.com

•

The OnCommand Insight data source Interoperability Matrix at mysupport.netapp.com/matrix.

Locating OnCommand Insight documentation
You can access the OnCommand Insight guides at the the NetApp Support Site
mysupport.netapp.com/documentation/productsatoz/index.html to learn how to use the product.

Locating IBM Cognos documentation
For basic information such as how to start and stop the Reporting portal software, see the IBM
Cognos documentation installed with the product. You can search with a web browser for
information about any of the IBM Cognos reporting products, such as Query Studio, Report Studio,
Business Insight, or Business Insight Advanced on the IBM website in the Information Centers for
those software products.
Steps

1. To locate the IBM Cognos documentation installed with OnCommand Insight, navigate to this
directory.
<install_dir>\cognos\c10_64\webcontent\documentation\help_docs.html

2. You can also display topics describing individual IBM Cognos windows used in the OnCommand
Insight Reporting Portal. Click the ? icon on the window toolbar.
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Reporting made easy
You can generate pre-defined reports from the OnCommand Insight Reporting Portal, email them to
other users, and even modify them. Several reports enable you to filter by device, business entity, or
tier. The reporting tools use IBM Cognos as a foundation and give you many data presentation
options.
•

The OnCommand Insight pre-defined reports show your inventory, storage capacity, chargeback,
performance, and storage efficiency data. You can modify the pre-defined reports and save your
modifications.

•

You can create custom reports using the OnCommand Insight Reporting Portal tools: Business
Insight and Business Insight Advanced.

•

OnCommand Insight provides quick access to report data through dashboards. Additionally, you
can group your own report selections and, using the Business Insight tools, you can display them
in your own dashboards.

The report data available to you is controlled by several things, including the following:
•

Login access to the OnCommand Insight Reporting Portal, which is defined by roles.

•

The setup of the OnCommand Insight Data Warehouse, which stores the data for the reports.

You can generate reports in various formats, including HTML, PDF, CSV and Excel.
OnCommand Insight accommodates multiple tenancy in reporting by enabling you to associate users
with business units. With this feature, administrators can separate data or reports according to the
attributes of a user or his affiliation.
For additional instructions about how to use the IBM Cognos features, see the Cognos online Help.
Related tasks

Locating IBM Cognos documentation on page 22

Accessing the OnCommand Insight Reporting Portal from
Data Warehouse
You can access the OnCommand Insight Reporting Portal directly from a web browser or from Data
Warehouse. Use the portal to access the predefined reports in the Query Studio or Report Studio
(where you can create your own reports using Data Warehouse data). IBM Cognos software is used
to create and generate the predefined reports.
About this task

This procedure describes how to access the portal from the Data Warehouse.
Steps

1. Open a web browser.
2. Enter the following URL:
http://host_name/dwh

3. Enter your user name and password, and then click OK.
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4. In the Data Warehouse main menu, click

.

5. From the login browser page that appears, enter your user name and password, and then click OK.
Result

The Storage Manager Dashboard is displayed.

Opening the OnCommand Insight Reporting Portal from a browser
You can access the OnCommand Insight Reporting Portal directly from a web browser.
Steps

1. Open a web browser.
2. Enter the following URL:
http://server-name/9300/p2pd/servlet/dispatch

9300 represents the default port specified during installation. If another port was specified, you
need to change the port.
3. Enter your user name and password, and then click OK.

Navigating to the pre-defined OnCommand Insight reports
and dashboards
When you open the Reporting Portal, the Public Folders tab is the starting point for you to select the
type of information you need in the reports and dashboards.
Steps

1. Click the Public Folders link and select the information category that you want to use.
2. In the information category, you can select dashboards, folders, and individual reports.
For example, the Capacity > Storage Capacity information category has Dashboards and Reports
links as well as custom folders for your own reports and dashboards.
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3. Click Dashboards or Reports to navigate to specific OnCommand Insight reports.
Related concepts

Locating predefined reports on page 6

Running a report
You can quickly run the pre-defined reports from the OnCommand Insight Reporting Portal. Some
reports might require you to select parameters that filter the data to be displayed in the generated
report.
Steps

1. Select the folder containing the types of reports you want.
2. Click the report link to generate the report or to open the parameter filtering page for that report.
3. If the report has a parameters page, select the report parameters you want to use to filter the data
displayed.
In many reports, you can leave the parameter selections untouched to select all of the possible
types.
4. Click Finish to generate the report.
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Managing reports
For each report, you can select the More link in the Actions column and access all of the report
operations, such as setting report properties, scheduling reports, or emailing reports. Administrators
have more management options available than other users.
Administrators can set permissions for other report users according to their OnCommand Insight
roles.
Related tasks

Customizing a report's output format and delivery on page 26

Customizing a report's output format and delivery
You can customize the format and delivery method of a pre-defined OnCommand Insight report.
Steps

1. Log into the OnCommand Insight Data Warehouse.
2. Open the OnCommand Insight Reporting Portal and select the report you want to customize.
3. To the right of the report name are several Actions icons and a More link. Click the Run with
options triangle icon to open the output format options for this report.

4. Set these options:
•

Format as HTML, PDF, Excel 2007, Excel 2003, Delimited Text (CSV), or XML

•

Accessibility check to enable accessibility support for this report

•

Language select from the list of available languages. The default is English (United States).

•

Delivery select to view the report, save it, or print the report on a selected printer

•

Prompt values check to prompt for values

5. Click Run to produce the report using the selections.
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Scheduling reports
You can set up the report to run at a recurring date and time and set its runtime priority. You can run
it using the default values or specify the options, and you can disable the schedule without losing any
of its details.
Steps

1. From the OnCommand Insight Reporting Portal, select the report.
2. Click the More link and then click New schedule.
3. Enter the schedule parameters for the report.
For more information about these selections, click the Help link.
4. Click OK.

Setting up email notification in Reporting Connection
Setting up email notification is required to send out reports from Query Studio or Reports Studio via
email.
Steps

1. From the Windows Start menu, select All Programs > IBM Cognos > IBM Cognos
configuration.
2. Under the Explorer column at the end, select Notification.
3. On the right side of the Notification screen, enter the following information:
•

SMTP mail server: Enter the server name registered in DNS or SMTP server IP, for example,
10.10.10.10:25.

•

Account and password needed to log into the mail server.

•

Default sender: Enter the email account that was added to the generated emails as the sender,
for example, user@domain.com.

4. Select File > Save.
5. In the Cognos Configuration window, right-click Local Configuration, and then select Restart
to restart the Cognos service.
You could also select Actions > Restart or Start if the server is not running.
6. Test the email server setting:
a. From the Windows Start menu, select All Programs > IBM Cognos > IBM Cognos
configuration.
b. Right-click Notification, and then select Test.
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Managing dashboards
OnCommand Insight provides report groupings in the form of dynamic dashboards to show different
views of data relating to a specific management concern. Clicking elements in the dashboards
displays more detailed information.
About this task

The dashboards group information on a subject of interest and provide these dynamic features:
•

Click on chart elements to regenerate charts showing more details for the selected items.

•

Links to other reports and more detailed information.

If you have a favorite dashboard, you can add a tab for it using one of these methods:
•

Add the dashboard tab from the public folders.

•

Add the dashboard tab from User Preferences.

Related tasks

Using dashboards to survey information and display details on page 30

Accessing dashboards and creating a dashboard tab
You might want to display a dashboard group of reports in a tab for easy access. You can add the tab
from the public folders list.
Steps

1. Open the OnCommand Insight Reporting Portal.
2. Select Public Folders > Storage Manager Dashboard.
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Individual reports and dashboards are listed together in the folder.
Within the package, several options appear, including Dashboards and Reports.
3. For quick access to a dashboard in the future create a separate tab for it by clicking the More link
to the right of the dashboard.
4. In the list that opens, click the Add to my portal tabs link.
The new tab is displayed at the top of the window with the selected dashboard as the tab label.

Adding a dashboard from User Preferences
You might want to display a dashboard group of reports in a tab for easy access. You can add the tab
from User Preferences.
Steps

1. Open the OnCommand Insight Reporting Connection.
2. At the upper right, click the Person icon to show a drop-down menu.

3. Select My Preferences.
4. In the Set preferences view, click the Portal Tabs tab.

5. In the Portal Tabs tab, click the Add link.
6. In the Public Folders and Dashboard folder, locate the dashboard that you want as a tab and check
it.
7. Click the arrow to move it to the Selected Entries box, and click OK.

30 | OnCommand Insight Reporting Guide

Using dashboards to survey information and display details
You can access report data through individual reports or by viewing that data in a group of report
results on a dashboard.
Steps

1. To display dashboards, open the OnCommand Insight Reporting Portal.
2. Select Public Folders and one of the report categories.
3. Select Dashboards.
The list that opens may contain reports, folders, and dashboards.
4. To open a dashboard, select an item in the list with the dashboard icon

beside it.

The dashboard might display immediately or require you to identify environment elements for the
reports and submit your selections.
5. In the dashboard, click items in graphs to open more detailed versions of the reports for those
specific items.
In this example, you might want to know more about the Gold-Fast tier, so you would click
portions of the graphs that depict that tier.

6. To display more information about data in report lists, click the links.
In the example, the Business Entity Accountability report in the Plan-Cost Accounting dashboard
contains linked information.
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7. At the bottom of most dashboards is a list of report links. Click any of these links to generate
additional reports.
Related tasks

Managing dashboards on page 28
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Inventory reports
OnCommand Insight provides reports that display inventory information.
The Inventory reports supply information in these categories:
•

Available FC and NFS paths

•

Connected ports

•

Data sources

•

Device inventory

•

Fabric summary

•

Glossary

•

Host data

•

Internal volumes

•

Mapped but not masked volumes

•

Qtree information

•

SAN path violation information

•

Switch connectivity

Inventory reports
The detailed Inventory reports provide information about devices, FC and NSF paths, connected
ports, devices, data sources, hosts, internal volumes, and qtrees.
You can access the Inventory reports from Public Folders > Packages or in the Inventory
Dashboards location.
You can create Inventory reports using the report authoring tools described in this guide.
Related concepts

Creating custom ad hoc reports on page 44

Fabric Summary report
This report contains an overview of all the fabrics in the environment. For each fabric, the report
indicates the switch ports that create the fabric.
Accessing this report
To display this report, select Public Folders > Reports > Fabric Summary.
Sample
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Report columns
The report includes these columns:
Switch Name
Name of the switch.
Switch Firmware
Version of the firmware running on the switch.
Serial Number
Serial number of the switch, if available.
Port Count
Number of ports that the switch can accommodate.
Connected Port Count
Number of switch ports connected to the fabric.
Licensed Port Count
Number of licensed ports on the switch.
Licensed Connected Port Count
Number of switch ports logically connected to the fabric.

Host HBAs report
This report contains an overview of hosts in the environment including the vendor, model, and
firmware version of HBAs, and firmware level of the switches to which they are connected.
Accessing this report
To display this report, select Public Folders > Reports > Host HBAs.
Report generation options
You can select one or more hosts for this report.
Sample
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Interpretation
The primary use of this report is to analyze firmware compatibility when doing a firmware upgrade
for a switch or an HBA.
Report columns
The report includes these columns:
Host
Selected host.
Host OS
Operating system running on the host.
Host Port WWN
World Wide Name of the HBA port.
HBA Vendor
Name of the vendor who sells the HBA.
HBA Model
Manufacturer’s model number for the HBA.
HBA Firmware Version
Version of the firmware running on the HBA.
HBA Driver
Version of the driver running the HBA.
Switch Serial Number
The serial number for the switch.
Switch Firmware Version
Version of the firmware running on the switch that is connected to the HBA.

Host Summary report
This report contains an overview of storage utilization by each selected host with information for
Fibre Channel and ISCSI hosts.
Accessing this report
To display this report, select Public Folders > Reports > Host Summary.
You can also generate this report by clicking a bar in the Host Capacity report.
Report generation options
You need to enter the names of one or more hosts and click Search. You can select some or all of the
search results and click Finish to generate this report.
Sample
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Interpretation
This summary report enables you to compare ports and paths and the Fibre Channel and ISCSI
capacity and violation counts.
Report columns
The report includes these columns:
Host Name
Selected host.
Port Count
Number of ports on that host.
FC Path Count
Number of paths connected to Fibre Channel hosts.
ISCSI Path Count
Number of paths connected to ISCSI hosts.
Accessed Capacity (TB)
Amount of storage that is accessible for host, in terabytes.
Accessed Raw Capacity (TB)
Actual raw disk capacity for the device, in terabytes.
FC Violation Count
Number of Fibre Channel host violations.
ISCSI Violation Count
Number of ISCSI host violations.

Mapped But Not Masked Volumes report
The Mapped But Not Masked Volumes report lists those volumes whose logical unit number (LUN)
has been mapped for use by a particular host, but are not masked to that host. Unmasked volumes can
be accessed by any host, making them vulnerable to data corruption.
Accessing the Mapped But Not Masked Volumes report
To view this report, you can select Public Folders > Reports > Mapped But Not Masked Volumes.
Report generation options
You can select one or more data centers, storage vendors, or volumes with capacities that are larger
than a specified amount. You can leave the selection boxes untouched to select all the data centers or
storage vendors.
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Sample report

Report columns
The Mapped But Not Masked Volumes report includes the following columns:
Data Center
Specifies the location of the storage array.
Tier
Specifies the storage tier (access priority) of the volume.
Storage
Specifies the name of the storage array.
Volume
Specifies the volume name.
Capacity (GB)
Specifies the sizes of the disks comprising the volume.
Volume Type
Specifies the types of disks comprising the volume—for example, SSD for solid state, or
FC for Fibre Channel.
LUN
Specifies the LUN or host volume ID.
Protocol Controller
Specifies the protocol converter through which the volume is mapped to the storage port
(applicable only for some types of storage arrays, such as EMC CLARiiON).
Storage Ports
Specifies the Worldwide Port Name of the storage controller ports.
Storage Targets
Specifies the Worldwide Node Name of the storage controller.

Storage Summary report
This report gives an overview of the storage devices in the environment. Storage devices are listed
with their vendor, model, and microcode or firmware version, as well as a brief summary of their
utilization.
Accessing this report
To display this report, select Public Folders > Reports > Storage Summary.
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Report generation options
You can select one or more data centers, storage vendors, storage families, storage models, and
storage names. Take no action in the selection boxes to select all data.
Sample

Report columns
The report includes these columns:
Data Center
Location of the storage array.
Storage Name
Name of storage array.
Backend/Virtual
Indication of virtualization. Identifies whether the storage acts as virtual storage (V),
backend storage (B), or both virtual and backend storage (BV). If virtualization is not
associated with the host, the column in the row for that host is displayed as empty.
Raw Capacity
The total physical capacity of all disks in the array.
Unconfigured Raw Capacity
Physical capacity of disks that are not configured into a storage pool, as well as spare and
failed disks.
Storage Pool Capacity
The size of the storage pool that is available for storing user data.
Storage Pool Used Capacity
The amount of usable capacity in use on the storage pool. This includes the capacity
consumed by internal volumes, volumes, Snapshot Reserve, and other storage efficiency
technology overheads.
Storage Pool Unused Capacity
The usable capacity that might be available for storing additional data on the storage pool.
Allocated Volume Capacity
The capacity of volumes accessed by hosts, used for replication and volumes that are
masked but no access path to them exists.
Unallocated Volume Capacity
The capacity of volumes that are not allocated. These volumes are not used for any
purpose.
Orphaned Volume Capacity
The capacity of volumes that are masked but no access path to them exists.
Protection Volume Capacity
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The capacity of volumes that are used for replication.
Internal Volume Capacity
The usable capacity of the internal volumes.
Internal Volume Used Capacity
The used capacity of the internal volumes.
Internal Volume Protection Capacity
The provisioned capacity of internal volumes that are used for replication.
Manufacturer
Name of manufacturer of the storage array.
Family
Product classification of the storage array (for example, CLARiiON or Symmetrix).
Model
Model number supplied by the manufacturer.
Microcode version
Version of firmware running on the storage array.
Serial Number
Serial number associated with the device.

VM Paths report
With this report, you can quickly identify the current virtual configuration.
Accessing this report
To display this report, select Public Folders > Reports > VM Paths.
Sample

Interpretation
You might want to use this report to see the following:
•

Which virtual machine is running on which host

•

Which hosts are accessing which shared volumes

•

What the active access path is

•

What comprises capacity allocation and usage

Report columns
The report includes these columns:
VM
Virtual machine name. Is blank when the row represents a SAN volume or a NAS share
that is being accessed from a virtual host (ESX) but does not contain virtual machine data.
VM IP
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IP address assigned to the virtual machine.
Host
Name of the host.
Host IP
IP address of the host.
OS
Guest operating system.
State
Shows the combined power state of the virtual hardware of the virtual machine and of the
guest OS: Running, Powered Off, Powered On, Not Running, Standby, Shutting Down,
Unknown, Suspended.
Resource Name
Name of the SAN volume or NAS logical disk where the data for this path resides. Might
be blank if one of the following occurs:
•

The SAN volume is accessible to the host but is not part of any database.

•

OnCommand Insight cannot identify the storage containing the virtual machine.

Resource Technology
Populates with either SAN or NAS values that indicate what storage technology is used by
the VM Path. Unlike the Client view, Resource Technology does not differentiate the SAN
value between FC and iSCSI.
Resource Capacity (GB)
Size of the volume, in gigabytes.
Datastore
Name of the datastore that resides on the volume and is used by the virtual machine.
Storage
SAN or NAS storage array name. Might be blank if OnCommand Insight cannot identify
the storage containing the virtual machine.
VM Capacity
Capacity allocated to the virtual machine on the datastore. This is the sum of all virtual
disks stored on the datastore that are used by the virtual machine.
Datastore Capacity
Storage capacity that is allocated to the datastore (provided by the SDK).
Datastore Free Capacity
Datastore capacity that is not allocated to virtual machines (provided by the SDK).
Datastore Utilization
The ratio of used capacity divided by total capacity. Shows how much capacity is being
used.
Powered Off Since
Time when the virtual machine was shut down, if it is not running.
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Capacity and chargeback dashboards and reports
The capacity, chargeback, and trending data provides information to plan the overall storage
allocation at a business level.
Senior managers, business unit managers, and application managers have different requirements for
capacity report information. A wide variety of reports to satisfy these needs are provided in these
report groups:
•

Capacity is a large group of reports with folders for file system utilization and capacity
information for internal volumes, ports, qtrees, storage, storage pools, and virtual machines.

•

Chargeback provides capacity accountability, historical capacity accountability, and trending
information.

•

Storage Efficiency supplies the NetApp Storage Capacity Efficiency Rating report.

Some report folders, reports, and reporting tabs are hidden for use only by advanced users. See
information about switching between simple and advanced reporting views.

Accessing capacity reports
In addition to the report dashboards, you can open individual capacity reports. To locate a report,
search for it in the Public Folders tab of the OnCommand Insight Reporting Connection. You can
also open a dashboard and select an individual report from the group of reports listed.
Steps

1. Open the OnCommand Insight Reporting Connection.
2. Click the Public Folders tab.
3. From the Public Folders tab, click Packages.
The report category names also include the version number of OnCommand Insight that is
installed in your environment.
4. Open any of these folders to access the individual capacity reports:
•

File System Utilization

•

Internal Volume Capacity

•

Port Capacity

•

Qtree Capacity

•

Storage and Storage Pool Capacity

•

Storage Capacity

•

VM Capacity

•

Volume Capacity

Storage Capacity and Storage Efficiency report folders, reports, and reporting tabs are hidden for
use only with advanced views. See information about switching between simple and advanced
reporting views.
5. Generate reports using the Report authoring tools.
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Storage Summary report
This report gives an overview of the storage devices in the environment. Storage devices are listed
with their vendor, model, and microcode or firmware version, as well as a brief summary of their
utilization.
Accessing this report
To display this report, select Public Folders > Reports > Storage Summary.
Report generation options
You can select one or more data centers, storage vendors, storage families, storage models, and
storage names. Take no action in the selection boxes to select all data.
Sample

Report columns
The report includes these columns:
Data Center
Location of the storage array.
Storage Name
Name of storage array.
Backend/Virtual
Indication of virtualization. Identifies whether the storage acts as virtual storage (V),
backend storage (B), or both virtual and backend storage (BV). If virtualization is not
associated with the host, the column in the row for that host is displayed as empty.
Raw Capacity
The total physical capacity of all disks in the array.
Unconfigured Raw Capacity
Physical capacity of disks that are not configured into a storage pool, as well as spare and
failed disks.
Storage Pool Capacity
The size of the storage pool that is available for storing user data.
Storage Pool Used Capacity
The amount of usable capacity in use on the storage pool. This includes the capacity
consumed by internal volumes, volumes, Snapshot Reserve, and other storage efficiency
technology overheads.
Storage Pool Unused Capacity
The usable capacity that might be available for storing additional data on the storage pool.
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Allocated Volume Capacity
The capacity of volumes accessed by hosts, used for replication and volumes that are
masked but no access path to them exists.
Unallocated Volume Capacity
The capacity of volumes that are not allocated. These volumes are not used for any
purpose.
Orphaned Volume Capacity
The capacity of volumes that are masked but no access path to them exists.
Protection Volume Capacity
The capacity of volumes that are used for replication.
Internal Volume Capacity
The usable capacity of the internal volumes.
Internal Volume Used Capacity
The used capacity of the internal volumes.
Internal Volume Protection Capacity
The provisioned capacity of internal volumes that are used for replication.
Manufacturer
Name of manufacturer of the storage array.
Family
Product classification of the storage array (for example, CLARiiON or Symmetrix).
Model
Model number supplied by the manufacturer.
Microcode version
Version of firmware running on the storage array.
Serial Number
Serial number associated with the device.

VM Capacity Summary report
The VM Capacity Summary report shows capacity information that includes provisioned capacity
and commit ratio by data stores. This report provides details about the virtual machine, including its
total capacity, provisioned capacity, and commit ratio.
Accessing this report
To display this report, select Public Folders > Capacity > VM Capacity > Reports > VM Capacity
Summary.
Report generation options
For this report, you select the data store names to be represented.
Sample
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Interpretation
These definitions and formulas are presented in this report:
Datastore
Name of the data store or volume.
Actual Capacity
Total amount of space available in the data store.
VM Name
Name of the virtual machine or machines.
ESX Host
Name of the Hypervisor host.
Provisioned Capacity
Amount of space vCenter reports as per guest VMs. Provisioned capacity on the data store
on the whole.
Commit Ratio
Ratio of data store provisioned capacity/Total capacity of the data store.
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Creating custom ad hoc reports
You can use the report authoring tools to create custom reports. You can also save reports to run on a
regular schedule and email results to yourself and others.
The example in this section shows the following processes, which can be used for any of the
OnCommand Insight data models:
•

Identifying a question to be answered with a report

•

Determining the data needed to support the results

•

Selecting data elements for the report

This section shows you how to create reports using different report authoring tools: Query Studio and
Workspace Advanced.

Report authoring tools
The OnCommand Insight enterprise reporting data models provide data elements and interactive
relationships among data elements that yield business views of the data. Using the data elements and
relationships, you can create reports using Query Studio, Report Studio, Workspace or Workspace
Advanced, which are report generation tools.
You can use the following report authoring tools to create reports with OnCommand Insight data
models:
•

With Query Studio, you drag and drop data elements to create customized ad hoc reports that
address your business needs.
Note: Although the OnCommand Insight documentation provides basic information about

creating reports using Query Studio, for details about Query Studio format options, see the
Cognos documentation.
•

With Report Studio, you can create more complex reports with complex filters, prompts, and
conditions.
You can create very complex reports using the Report Studio tool and OnCommand Insight data.
Report Studio is a powerful tool, and its use is beyond the scope of this guide.

•

With Workspace, you can create and assemble dashboards and create interactive reports.

•

With Workspace Advanced, you can create rich, interactive reports with a tool that has all the
functionality of Query Studio, Report Studio Express, and Analysis Studio.

Some authoring tools are hidden for use only with advanced views.

What you need to do before you design your report
Before you design your custom report, you need to complete some prerequisite tasks. If you do not
complete these, reports could be inaccurate or incomplete.
For example, if you do not finish the identification process, your capacity reports will not be
accurate. Or, if you do not finish setting annotations (such as tiers, business units, and data centers),
your custom reports will not show reports accurately across your domain and might show "N/A" for
some data points.
Before you design your reports, complete the following tasks:
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•

Configure all data sources. For details, see the OnCommand Insight Installation and
Administration Guide.

•

Identify all devices in your environment. For details, see the identification chapters in the
OnCommand Insight Inventory User Guide for the Java UI.

•

Enter as many annotations (such as tiers, data centers, and business units) on devices and
resources in your environment as possible. It is beneficial to have annotations stable before
generating reports, because OnCommand Insight Data Warehouse collects historical information.

•

Configure OnCommand Insight Data Warehouse to accept the data from the OnCommand Insight
server in the Extract, Transform, and Load (ETL) process.

Process of creating reports
The process of creating ad hoc reports involves several tasks.
•

Plan the results of your report.

•

Identify data to support your results.

•

Select the data model (for example, Chargeback data model, Inventory data model, and so on)
that contains the data.

•

Select data elements for the report.

•

Optionally format, sort, and filter report results.

How to plan the results of your custom report
Before you open the Query Studio or Business Insight Advanced report design tools, you might want
to plan the results you want from the report. With these report authoring tools, you can create reports
easily and might not need a great deal of planning; however, it is a good idea to get a sense from the
report requestor about the report requirements.
•

Identify the exact question you want to answer.

•

Identify the data elements that you need to support the answer.

•

Identify the relationships between data that you want to see in the answer. Do not include illogical
relationships in your question, for example, “I want to see the ports that relate to capacity.”

•

Identify any calculations needed on data.

•

Determine what types of filtering are needed to limit the results.

•

Identify how the report will be distributed. For example, should it be emailed on a set schedule,
located on a dashboard, or included in a OnCommand Insight Reporting Connection My Folders
area?

•

Determine who will maintain the report. This might affect the complexity of the design.

•

Create a mockup of the report.

Here are some examples of questions you can answer by creating your custom reports and the
OnCommand Insight Data Warehouse model:
•

How much capacity do I have left?

•

What are the chargeback costs per business unit?

•

What is the capacity by tier to ensure that business units are aligned at the proper tier of storage?
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•

How can I forecast power and cooling requirements? (Add customized metadata by adding
annotations to resources.)

Tips for designing reports
Several tips might be helpful when you are designing reports.
•

Determine whether you need to use current or historical data.
Most reports only need to report on the latest data available in the Data Warehouse.

•

Data Warehouse provides historical information on capacity and performance, but not on
inventory.

•

Everybody sees all data; however, you might need to limit data to specific audiences.
To segment the information for different users, you can create reports and set access permissions
on them.

Creating your first Query Studio report
The most important part of the of the report design is determining the question you want to answer
with your report and selecting data to support that result.
This example creates a report that answers the following question: Which data center is using the
most capacity in the top level (most expensive) tier?
This is the report that this example wants to achieve.

To design this report, you use the Storage Capacity data model from the Advanced data mart
including the following data elements:
•

Business Unit (or if you want the entire Business Entity information, you could select Business
Entity)

•

Tier

•

Physical Raw Capacity

•

Tier Cost

You might want to enhance the report by doing the following:
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•

Group by business unit.

•

Sort the data by capacity in descending order.

•

Filter any business units that are not needed.

Accessing Query Studio
You must open the OnCommand Insight Reporting Portal and access Query Studio to create sample
reports in all data models.
About this task

Use these steps to access Query Studio for any specific data model.
Steps

1. Open a web browser and enter the following URL:
http://<host-name>/reporting

2. Enter your user name and password, and then click OK.
This gives you access to the OnCommand Insight Reporting Portal. The Portal can be accessed in
several ways. For other methods, see information about accessing the OnCommand Insight
Reporting Portal.
3. Select Insight Reporting Content to open the OnCommand Insight Reporting Connection.

4. Click the link for the data model you want to access.
5. When the next view opens, from the Launch Menu on the upper right-hand corner, select Query
Studio.
The Query Studio opens and provides access to the data model you selected.
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Selecting the data model and data elements for your report
The OnCommand Insight Reporting Portal provides several data models that focus the area of your
report. Each data model appears as a separate folder tab.
Steps

1. From the OnCommand Insight Reporting Portal, select Insight Reporting Content.
The list of data models appears. If you do not have a license for the specific tabs, a warning icon
appears on the tab. If you login as an administrator, you see folders instead of tabs.

2. Click on the link of the data model for which you are running the report. For this example, click
the Capacity folder, then the Storage Capacity link.
3. From the Launch menu on the upper right corner, select a report authoring tool, such as Query
Studio.
The report authoring tool opens and provides access to the data model you selected.

Filtering and sorting data
Filter data to limit the results and sort the data to show capacity in descending order.
Steps

1. Highlight the Business Unit column. Click the Filter icon and remove "N/A" from the list.
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2. Highlight the Provisioned Raw Capacity column and click on the Sort icon. Arranging in
descending order.

Pivoting the report
You can click on a column and create a crosstab report by pivoting the report. When you do this, the
selected column values become the values across the top of the report.
Steps

1. To create the crosstab report, select the column that will become the values across the top.
2. Click the Pivot icon.
Here is a sample report before pivoting.

Here is a sample of the same report after pivoting.

Saving your report
You should save your reports in a folder other than the My Folders folder. When reports are backed
up and restored in OnCommand Insight, the My Folders content is not included in the backup.
Steps

1. From Query Studio, click on the Save icon.
2. Select a folder other than the My Folders folder.
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3. Enter a name for your report.

Selecting another data model for more reporting
When you want to create reports using another data model, you can exit the current data model and
select another.
Steps

1. From Query Studio, click the Home icon in the upper-right corner.
2. From the Launch menu in the upper-right corner, select Query Studio.

Returning to OnCommand Insight Data Warehouse
When you have finished using Query Studio, you can return to Data Warehouse easily.
Steps

1. From the upper right side of Query Studio, click on the Return arrow.
If you are creating a report, a message appears at the bottom asking if you want to save the report.
2. To save the report, click Yes.

Creating reports with Workspace Advanced
You can create custom reports using Workspace Advanced, a report authoring tool.
About this task

You can create the following sample reports:
•

Report sample 1: Raw Capacity by Data Center (table)

•

Report sample 2: Raw Capacity by Data Center (chart added to first example)

Creating a sample report: Raw Capacity by Data Center (table)
This example shows how to create a basic table report using OnCommand Insight Workspace
Advanced.
About this task

This report shows the distribution of raw capacity by data center. The report is created using the
Storage and Storage Pool Capacity data model.

Steps

1. Access the OnCommand Insight Reporting Connection using this URL: https://reportingserver/reporting
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2. From the Launch menu (at the top right corner of the Storage Manager Dashboard), click
Workspace Advanced.
3. From the Public Folders list, click Capacity > Storage and Storage Pool Capacity.
4. In the Workspace Advanced landing page, click Create new.
5. From the pre-defined report layouts New pop-up, choose List and click OK.
6. In the right pane, click the Source tab.
7. In the tree, expand Storage and Storage Pool Capacity.
8. Expand Data Center to see a child Data Center.
9. Drag the child Data Center to the list.
10. Expand Capacity (TB) and drag Raw Capacity (TB) into the report area to the right of the Data
Center column.
11. Click Save and save the report in the Customer Reports folder.

Creating a sample report: Raw Capacity by Data Center (chart)
This example shows you how to add a chart to a basic table report using OnCommand Insight
Workspace Advanced.
About this task

This report shows the distribution of raw capacity by data center with a chart. The report is created
using the Storage and Storage Pool Capacity data model.
Steps

1. Use the sample Raw Capacity by Data Center report as a base.
2. To create a page layout that includes both the List and Chart, select the Page Layout drop-down
menu and choose the two-column layout.

The report page updates showing two columns.
3. In the right pane, click the Toolbox tab.
4. Select Chart and place it over the right column work area.
5. From the Insert Chart dialog box, select Pie, Donut, (use the pie chart selected by default), and
then click OK.
6. In the right pane, select the Source tab.
7. In the tree, expand Storage and Storage Pool Capacity > Physical Capacity > Capacity (TB) >
Raw Capacity (TB).
8. Drag Raw Capacity (TB) and place it on the Default Measure section of the chart.
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9. From the Physical Capacity folder, drag the child Data Center element and place it on the Series
(pie-slices) section of the chart.
10. Click Save and save the report in the Customer Reports folder.

Importing and exporting report definitions in Report Studio
In OnCommand Insight Reporting, the Report Studio application provides an easy method for
importing and exporting report definitions in an XML format.
This allows you to add new reports posted in NetApp forums to your OnCommand Insight Reporting
installation. In addition, this feature is useful to back up report definitions and exchange reports with
colleagues.
To create these reports, you must have a license for the OnCommand Insight Plan module.
You do not have to specify a package when importing XML. The package is specified as part of the
XML.

Reporting data model
Your enterprise can benefit from the data that is discovered and stored in OnCommand Insight Data
Warehouse. The OnCommand Insight Data Warehouse is a centralized repository that stores data
from multiple information sources and transforms them into a common, multidimensional data model
for efficient querying and analysis.
From this repository, you can generate custom reports such as chargeback, consumption analysis, and
forecasting reports that answer questions such as the following:
•

What inventory do I have?

•

Where is my inventory?

•

Who is using our assets?

•

What is the chargeback for allocated storage for a business unit?

•

How much headroom do I have on switch ports?

•

How long until I need to acquire additional storage capacity?

•

Are business units aligned along the proper storage tiers?

•

How is storage allocation changing over a month, quarter, or year?

Using the data model provided with OnCommand Insight Reporting, you can use report authoring
tools, such as Query Studio, Report Studio, Business Insight, or Business Insight Advanced, to
design and schedule reports. You can access the report authoring tools from the OnCommand Insight
Reporting portal.

Data model overview
OnCommand Insight provides several data models for use in report development. Each data model is
an aggregation that summarizes data so that it can be queried and searched. For example, reports
about capacity planning use the Capacity data model.
The OnCommand Insight enterprise reporting data models provide data elements and interactive
relationships among data elements that yield business views of the data. Using the data elements and
relationships, you can create reports using Query Studio, Report Studio, Business Insight or Business
Insight Advanced, which are report generation tools.
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OnCommand Insight also provides data marts that can be used to develop your own SQL queries.
There is a distinction between these SQL query data marts and the data models used in reporting. The
individual OnCommand Insight reporting data models use the underlying OnCommand Insight
database schema provided in the data marts; however, the data models use additional tables and
sometimes new elements in the tables. For instance, the data model includes a Monthly Capacity Fact
table in the Storage Capacity data model that is based on the Capacity Fact table from the database
schema and data mart. The data model filters out the values from the database schema table to show
only month information.
Another example of a difference between the database schema used in data marts and the data model
is in the Violation table and the Violation Type column. The data model translates programmaticnamed values in the database to match the text displayed in the OnCommand Insight Client.
OnCommand Insight data models
OnCommand Insight includes several data models from which you can either select predefined
reports or create your own custom report.
Capacity data model
Enables you to answer questions about storage capacity, file system utilization, internal
volume capacity, port capacity, qtree capacity, and virtual machine (VM) capacity. The
Capacity data model is a container for several capacity data models.
Storage and Storage Pool Capacity data model
Enables you to answer questions about storage capacity resource planning, including
storage and storage pools, and includes both physical and virtual storage pool data.
This simple data model can help you answer questions related to capacity on the
floor and the capacity usage of storage pools by tier and data center over time.
If you are new to capacity reporting, you should start with this data model because it
is a simpler, targeted data model.
File System Utilization data model
Enables you to answer questions about file system utilization. This data model
provides visibility about capacity utilization by hosts at the file system level.
Administrators can determine allocated and used capacity per file system, determine
the type of file system, and identify trending statistics by file system type.
Internal Volume Capacity data model
Enables you to answer questions about internal volume used capacity, allocated
capacity, and capacity usage over time.
Port Capacity data model
Enables you to answer questions about switch port connectivity, port status, and
speed over time. This data can be used when planning for the purchase of new SAN
switches.
Qtree Capacity data model
Enables you to trend qtree utilization (with data such as used versus allocated
capacity) over time. You can view the information by different dimensions—for
example, by business entity, application, tier, and service level.
VM Capacity data model
Enables you to report your x (VM) environment and its capacity usage. This data
model lets you report on changes in capacity usage over time for VMs and data
stores. The data model also provides thin provisioning and virtual machine
chargeback data.
Volume Capacity data model
Enables you to analyze all aspects of the volumes in your environment and view them
by vendor, model, tier, service level, and data center. You can view the capacity
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related to orphan volumes, unused volumes, and protection volumes (used for
replication). You can also see different volume technologies (iSCSI or FC), and
compare virtual volumes to non-virtual volumes for array virtualization issues.
Chargeback data model
Enables you to answer questions about used capacity and allocated capacity on storage
resources (volumes, internal volumes, and qtrees). This data model provides storage
capacity chargeback and accountability information by hosts, application, and business
entities, and includes both current and historical data. Report data can be categorized by
service level and storage tier.
You can use this data model to generate chargeback reports by finding the amount of
capacity that is used by a business entity. This data model enables you to create unified
reporting of multiple protocols (including NAS, SAN, FC, and iSCSI).
Inventory data model
Enables you to answer questions about inventory resources such as hosts, storage systems,
switches, disks, tapes, qtrees, quotas, virtual machines and servers, and generic devices.
The Inventory data model includes several submarts that enable you to view information
about replications, FC paths, iSCSI paths, NFS paths, and violations. The Inventory data
model does not include historical data.
Performance data model
Enables you to answer questions about performance for volumes, application volumes,
internal volumes, switches, applications, VMs, VMDKs, ESX versus VM, hosts, and
application nodes.
The Performance data model includes information that helps you determine the
appropriateness of tiers, storage misconfigurations for applications, and last access times
of volumes and internal volumes. This data model provides data such as response times,
IOPs, throughput, number of writes pending, and accessed status.
Storage Efficiency data model
Enables you to track the storage efficiency score and potential over time. This data model
stores measurements of not only the provisioned capacity, but also the amount that is used
or consumed (the physical measurement). For example, when thin provisioning is enabled,
OnCommand Insight indicates how much capacity is taken from the device. You can also
use this model to determine efficiency when deduplication is enabled.
Data model fact and dimension tables
Each data model includes both fact and dimension tables.
•

Fact tables: Contain data that is measured, for example, quantity, raw and usable capacity.
Contain foreign keys to dimension tables.

•

Dimension tables: Contain descriptive information about facts, for example, data center and
business units. A dimension is a structure, often composed of hierarchies, that categorizes data.
Dimensional attributes help describe the dimensional values.

Using different or multiple dimension attributes (seen as columns in the reports), you construct
reports that access data for each dimension described in the data model.
For explanations of all data elements used in creating reports, see the Data Glossary.
Colors used in data model elements
Colors on data model elements have different indications.
•

Yellow assets: Represent measurements.

•

Non-yellow assets: Represent attributes. These values do not aggregate.
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Using multiple data models in one report
Typically, you use one data model per report. However, you can write a report that combines data
from multiple data models.
To write a report that contains only one data model, choose the data model and use one of two report
authoring tools, Query Studio or Report Studio.
To write a report that combines data from multiple data models, choose one of the data models to use
as the base, then write SQL queries to access the data from the additional data marts. You can use the
SQL Join feature to combine the data from the different queries into a single query that you can use
to write the report.
For example, say you want the current capacity for each storage array and you want to capture
custom annotations on the arrays. You could create the report using the Storage Capacity data model.
You could use the elements from the Current Capacity and dimension tables and add a separate SQL
query to access the annotations information in the Inventory data model. Finally, you could combine
the data by linking the Inventory storage data to the Storage Dimension table using the storage name
and the join criteria.

Capacity data models
Capacity data models enable you to answer questions about storage capacity, file system utilization,
internal volume capacity, port capacity, qtree capacity, storage pools, and VM capacity. The Capacity
data model is a container for several capacity data models.
•

Storage and Storage Pool Capacity data model. If you are new to capacity reporting, you should
start with this data model, because it is a simpler, targeted data model.

•

File System Utilization data model

•

Internal Volume Capacity data model

•

Port Capacity data model

•

Qtree Capacity data model

•

Storage Capacity data model

•

VM Capacity data model

•

Volume Capacity data model

File System Utilization data model
The File System Utilization data model enables you to answer questions about file system utilization.
This data model provides visibility into capacity utilization by hosts on the file system level.
Administrators can determine allocated and used capacity per file system, determine the type of file
system, and identify trending statistics by file system type.
File systems make use of an underlying data storage device that offers access to an array of fixed-size
blocks, for example, a local hard drive, SAN LUN, or SAN volume. For each file system, you can
determine the type of file system, for example, NTFS or FAT32.
You can answer the following types of questions using the File System Utilization data model:
•

What is the capacity (allocated and used) per FS?

•

Where is the data kept and how is it accessed, for example, local, SAN, or NAS?

•

What type of file systems (for example, NTFS, FAT, UFS, VxFS, and ISO 9660) do we have and
how many of each?
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•

What are the trending statistics for the file system type and capacity?

FS Utilization data model details
The File System Utilization data model contains a simple data mart and an advanced data mart.
•

Simple: Provides quick access to the most commonly used data elements. Includes only the last
snapshot of Data Warehouse data; it does not include historical data.

•

Advanced: Provides all values and details available from the simple data mart, including access to
historical data values. All data elements in the Simple data mart are also included in the
Advanced data mart.

FS data
This data model provides visibility into capacity utilization by hosts on the file system level.
Administrators can determine allocated and used capacity per file system, determine the type of file
system, and identify trending statistics by file system type.
The fields and field descriptions are as follows:
Allocated Capacity
See "Capacity concepts" information.
File System Name
Mounting point or drive letter.
Hardware ID
Host-specific identifier.
Host name
Representative host accessing the capacity.
Host OS
Operating system running on the host, if available to OnCommand Insight.
Host IP
IP address assigned to the host device.
Location
Indicates where the data is kept and how it is accessed, for example, local, SAN, or NAS.
Manufacturer
Name of manufacturer that makes the device.
Model
Manufacturer’s model number.
Type
File system type, for example, NTFS, FAT, UFS, UDF, ZFS, ISO 9660, or VXFS.
Used Capacity
See "Capacity concepts" information.
FS advanced data mart
The FS advanced data mart contains various fact and dimension tables.
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•

Date Dimension: Includes dates and time periods from which you can select for the report. Each
capacity fact is associated with the date when the Data Warehouse build ran that generated the
fact.

•

File System Dimension: Provides attributes (such as FS name, location, and type).

•

Host Dimension: A representative host from the group of hosts using the capacity.

•

File System fact: Includes the capacity data for the FS.

Internal Volume Capacity data model
The Internal Volume Capacity data model enables you to answer questions about internal volume
used capacity, allocated capacity, and capacity usage over time.
You can answer the following types of questions using the Internal Volume Capacity data model:
•

Which internal volumes have a utilization higher than a predefined threshold?

•

Which internal volumes are in danger of running out of capacity based on a trend?

•

What is the used capacity versus the allocated capacity on our internal volumes?

Creating a sample report with the Internal Volume Capacity data model
This report shows internal volume capacity per data center and vendor allocation by internal volume,
storage and tier.
About this task

The following illustration shows the report that you will create with these instructions, although your
data will be different.
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Steps

1. Access Query Studio.
For detailed steps, see the related links about accessing Query Studio.
2. From a blank screen in Query Studio showing the Internal Volume Capacity data model, select
Advanced Data Mart.
3. Select Storage Dimension > Storage Name and drag it into the work area.
4. Select Internal Volume Dimension > Internal Volume Name and drag it into the work area.
5. Select Tier Dimension > Tier Name and drag it into the work area.
6. Select Internal Volume Capacity Fact > Allocated Capacity GB and drag it into the work area.
7. Select Internal Volume Capacity Fact > Used Capacity GB and drag it into the work area.
8. Optionally, group the report by Storage Name by clicking the Storage name column and then the
Group icon in the upper right.
Internal Volume Capacity data model details
The Internal Volume Capacity data model contains a simple data mart and an advanced data mart.
•

Simple: Provides quick access to the most commonly used data elements. Includes only the last
snapshot of Data Warehouse data; it does not include historical data.

•

Advanced: Provides access to historical data values. All data elements in the Simple data mart are
also included in the Advanced data mart.

Internal Volume Capacity data
This data model enables you to answer questions about internal volume used capacity, allocated
capacity, and capacity usage over time.
The fields and field descriptions are as follows:
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Application
Applications such as your email, finance, development or human resources applications.
Application URL
URL of the application.
Internal Volume
The logical layer in storage devices that is not externally accessible as a SAN volume or
NAS share. An internal volume is carved from a storage pool and exposed to hosts as a
share or LUN.
Internal Volume URL
URL of the internal volume.
Allocated Capacity
The allocated size of the internal volume.
Business Unit
The business unit for the representative application of all applications accessing this
internal volume.
Consumed Capacity
The amount of capacity taken from the underlying storage pool for this internal volume
after applying storage efficiency technology overhead. Consumed capacity is less than or
equal to used capacity, depending on the storage efficiency technology applied to this
internal volume.
Data Unused Capacity
Capacity in the internal volume that is available for writing NAS data or allocating
volumes.
Data Used Capacity
Capacity in the internal volume that is used by hosts (volumes or NAS shares).
Deduplication Ratio
A number between 0 and 1 that represents the deduplication compression ratio applicable
to the capacity measured in this fact.
Note: The OnCommand Insight Client includes a Deduplication Savings column on the
Internal Volumes detail view. This represents the rate of savings in the internal volume.
For example, 1/3 of capacity is saved by using deduplication. The Data Warehouse and
reports show a Deduplication Ratio data element. This represents the rate of
compression that occurs from using deduplication, complementary data related to
Deduplication Savings. In the example where Deduplication Savings is 1/3, the
Deduplication Ratio is 2/3.

Deduplication Savings
Rate of savings in the internal volume by using deduplication.
Nondeduplication Capacity
Capacity on the internal volume that does not have deduplication technology applied to it.
Estimation of the consumed capacity assuming deduplication was turned off.
(ConsumedCapacity)÷ (Dedupe Ratio)
Number of Snapshots
A count of how many Snapshot copies were created on the internal volume.
Protection Type
Type of protection used on the storage, for example, Mirrored or Striped.
Raw Capacity
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The physical disk capacity. This differs from usable capacity when technologies such as
RAID are used, where some of the raw capacity is used for protection purposes.
Raw Allocated Capacity
The raw allocated size of the internal volume.
Raw Data Used Capacity
Raw capacity in the internal volume that is used by hosts (volumes or NAS shares).
Raw Consumed Capacity
The raw amount of capacity taken from the underlying storage pool for this internal
volume.
Raw Data Unused Capacity
Raw capacity in the internal volume that is available for writing NAS data or allocating
volumes.
Raw Total Clone Saved Capacity
Raw capacity on cloned internal volumes that is shared with the source of the clone.
Raw Snapshot Allocated Capacity
Raw capacity on the internal volume that is reserved for Snapshot copies.
Raw Snapshot Unused Capacity
Raw capacity remaining after some capacity that was reserved for Snapshot copies was
not used. This excludes capacity that was used for protection purposes.
Raw Snapshot Used Capacity
Raw capacity that has been used for Snapshot copies.
Snapshot Allocated Capacity
Capacity on the internal volume that is reserved for Snapshot copies.
Snapshot Unused Capacity
Capacity remaining after some capacity that was reserved for Snapshot copies was not
used. This excludes capacity that was used for protection purposes.
Snapshot Used Capacity
Capacity that has been used for Snapshot copies. Can exceed Snapshot Allocated Capacity
in the case of Snapshot Overflow.
Service Level
Service level represents the agreement between a service consumer or application and the
storage service provider, associated with an application. Service level differs from tier.
For example, you might have multi-tiered storage pools including 1 FC pool and one SSD
pool. Your service level policy might require that Tier 1 should sustain 5,000 IOPS.
However, because this LUN uses only 100 IOPS, the service provider might decide to
move this service to a lower tier that sustains only 500 IOPS. The service level is 5,000 or
500 IOPS, while the tier represents the quality of service, for example, gold or silver.
Service Level Cost
Cost / GB is the cost per gigabyte for a service level.
The service level cost can be the cost of providing the service or the actual price to service
the consumer, while the tier cost is the average cost per GB for the specific tier.
Storage Access Type
Indication of the type of access to the storage, SAN or NAS.
Tier Name
Level of service (for example, gold, silver, or bronze).
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Tier Cost
Unit of cost per gigabyte assigned to the tier level.
Time of Last Snapshot
The date and time when the most recent Snapshot copy was created.
Total Clone Saved Capacity
Capacity on cloned internal volumes that is shared with the source of the clone.
Used Capacity
Capacity in the internal volume used by hosts (volumes and NAS shares) including
Snapshot Used Capacity. Used Capacity is no less than Consumed Capacity, depending on
the storage efficiency technology applied to this internal volume.
Internal Volume Capacity advanced data mart
The Advanced data mart contains the full table data structure, which contains all current and
historical data.
The Advanced data mart is organized into the following fact and dimension tables:
•

Application Dimension

•

Application Group Dimension

•

Business Entity Hierarchy

•

Current Internal Volume Capacity Fact: Includes only the current capacity values. This table is
used most often, for writing reports that reflect the current state of the storage environment (as of
the last Data Warehouse build).

•

Internal Volume Capacity Fact

•

Weekly Internal Volume Capacity Fact

•

Monthly Internal Volume Capacity Fact

•

Quarterly Internal Volume Capacity Fact

•

Date Dimension: Includes dates and time periods from which you can select for the report. Each
capacity fact is associated with the date when the Data Warehouse build ran that generated the
fact.

•

Internal Volume Dimension: Defines the internal volumes, which are the logical layers in storage
devices that are not externally accessible as SAN volumes or NAS shares.

•

Service Level Dimension

•

Storage Dimension: Provides attributes (such as storage name, IP, model, manufacturer, family,
and type). Also includes data center.

•

Storage Pool Dimension: Defines the storage pools from which the capacity is taken.

•

Tier Dimension: Defines the tier based on the tier annotations in OnCommand Insight.

•

Virtual Storage Dimension: Includes the name, data center, IP, and other information about virtual
front-end storage for back-end capacity in storage virtualization.
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Port Capacity data model
The Port Capacity data model enables you to answer questions about switch port connectivity, port
status, and speed over time. This data can be used when planning for purchases of new SAN
switches.
The Port Capacity data model:
•

Provides easy access to switch capacity information recorded in the OnCommand Insight Data
Warehouse.

•

Provides access to information about switches, switch ports and port connectivity.

•

Enables the creation of detailed and accurate port capacity and connectivity reports based on
various criteria, such as data center, port speed, switch vendor, and connectivity type.

•

Maintains historical data to generate reports for past periods (last week, last month, last quarter,
and so on)

•

Allows the creation of capacity trend reports using historical data.

You can answer the following types of questions using the Port Capacity data model:
•

What types of ports are needed by port speed or vendor?

•

In what location is this capacity needed?

•

What is the optimal time to purchase that capacity and make it available?

•

How much more capacity exists on the switch ports?

Creating a sample report with the Port Capacity data model
The report generated in this example will answer the question: How do you get an active view of
ports in your environment?
About this task

The following example shows the process, and it can be used for any of the tables described in the
Port Capacity data model.

Steps

1. Access Query Studio.
For detailed steps, see the related links about accessing Query Studio.
2. In Query Studio, expand the Simple Data Mart.
3. Select the Port Count element and drag it to the work area.
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4. Select the Port Speed element and drag it into the work area.
5. Select the Data Center element and drag that into the work area.
The result is a table of values listing all ports and their speeds according to the Data Center
location.
6. Optionally, to filter out any missing values or "N/A" values, click on the Data Center column and
click Filter.
7. To group the data, click on the Data Center column and click the Group icon.
8. Optionally, click on the Pivot icon to create a crosstab format for the report.
In this example, you can see how many active ports each data center has, which ones are running
at 1G or 4G, and their totals. This information provides a clear and rapid view into resource
allocation.
Port Capacity data model details
The Port Capacity data model contains a simple data mart and an advanced data mart.
•

Simple: Provides quick access to the most commonly used data elements. Includes only the last
snapshot of Data Warehouse data; it does not include historical data.

•

Advanced: Provides access to historical data values. All data elements in the Simple data mart are
also included in the Advanced data mart.

Port Capacity data
This data model enables you to answer questions about switch port connectivity, port status, and
speed over time.
The fields and field descriptions are as follows:
Connected to Firmware
Firmware running on the port to which the port identified by the Name field is physically
connected.
Connected to Name
Device and port to which the port identified by the Name field is physically connected.
Connected to Type
Protocol to which the port identified by the Name field is physically connected.
Data Center
Location of data center, based on the switch’s data center annotation in OnCommand
Insight.
Free Port Count
Number of free ports on the switch.
GBIC Type
The type of Gigabit Interface Converter (GBIC) used for the port.
Generated
Real FC ports for which OnCommand Insight does not know their WWN. Generated ports
for NPV switches or clustered Data ONTAP storage.
NPV
N-port virtualization (NPV) devices that OnCommand Insight detects in your
environment. Applies to FC network only.
Port Connectivity Type
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Type of connectivity.
Port Count
Number of ports on the switch.
Port Fabric
Fabric on which the port is configured to operate.
Port Speed
Speed capability of the port, in gigabytes.
Port Status
Current status of the port, taken from the device itself. Possible values are OK, NOT
LICENSED, ERROR, INACTIVE and UNKNOWN.
Port Type
Typically used to identify the protocol used to communicate with the other device, taken
from the device itself: F-port, E-port, and so on.
Port WWN
WWN (World Wide Name) to identify the port.
Switch Firmware
Version of the firmware running on the switch.
Switch Level
Core, Host, Storage or User-defined (Annotation level assigned to the switch).
Switch Level Cost
Port cost associated with each switch level, as set in the OnCommand Insight Client’s
OnCommand Insight Settings > Cost Accounting page.
Switch Manufacturer
Name of the manufacturer who makes the switch.
Switch Name
Switch name, as provided by the SAN manager at the switch console.
Port Capacity advanced data mart
The full table data structure is provided for the Port Capacity data model in the Advanced Data Mart,
which contains all current and historical data.
The data mart includes the following dimensions and fact tables:
•

Connected To Dimension: Information about the device the switch port is connected to (storage
array / host / switch / tape / generic device).

•

Date Dimension: Includes dates and time periods from which you can select for the report. Each
port fact is associated with the date when the Data Warehouse build ran generated the fact.

•

Port Dimension: Describes a switch port.

•

Switch Dimension: Defines the switch owning the port.

•

Time period fact tables: Provides historical data in your reports.
◦

Current Ports Capacity Fact: Includes only the current port values. This table is used most
often, for writing reports that reflect the current state of the storage environment (as of the last
Data Warehouse build).

◦

Weekly Ports Capacity Fact

◦

Monthly Ports Capacity Fact
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◦
•

Quarterly Ports Capacity Fact

Ports Fact table: Includes the full set of port data for every Data Warehouse build performed.

Qtree Capacity data model
The Qtree Capacity data model enables you to track qtree utilization trends (with data such as used
versus allocated capacity) over time. You can also organize the information by different dimensions,
for example, by business entity, application, tier, and service level.
Quotas are typically set up by storage administrators on shares or qtrees. Space quotas that indicate
the limits on the amount of usable space or the number of files that can be created on a NAS share or
qtree. The following types of limits apply:
•

Hard limit: The disk space limit imposed on this qtree by a quota. If this is exceeded, data cannot
be written.

•

Soft limit: The soft quota space limit that, if exceeded, issues warnings rather than rejects space
requests.

OnCommand Insight displays the limit data:
•

If a hard limit exists, but a soft limit does not, the soft limit receives the value of the hard limit,
and vice versa.

•

If both hard and soft limits are not specified, they use the value of the internal volume allocated
capacity.

Qtree capacity facts are purged after a default time threshold. For details, see Data Warehouse
processes.
You can answer the following types of questions using the Qtree Capacity data model:
•

What is the used capacity for qtrees versus the limits set per application or business entity?

•

What are the trends of our used and free capacity so that we can do capacity planning?

•

Which business entities are using the most capacity?

•

Which applications consume the most capacity?

Creating a sample report with the Qtree Capacity data model
This example creates a report that shows qtree information, its internal volume, and hard and soft
limit capacities.
About this task

Steps

1. Access Query Studio.
For detailed steps, see the related links about accessing Query Studio.
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2. From a blank screen in Query Studio showing the Qtree Capacity data model, expand Advanced
Data Mart.
3. Expand Business Entity Hierarchy, select Business Unit, and drag it into the work area.
4. Expand Storage Dimension, select Storage, and drag it to the right of Business Unit in the work
area.
5. Expand Qtree Dimension, select Qtree, and drag it into the work area.
6. Expand Internal Volume Dimension, select Internal Volume, and drag it into the work area.
7. Expand Qtree Capacity Fact, select Used Capacity, Hard Limit Capacity, and Soft Limit
Capacity and drag them into the work area.
8. Optionally, group the report by Business Unit by clicking the Business Unit column and then the
Group icon in the upper right.
9. Click the Title and enter the report title.
Qtree Capacity data model details
The Qtree Capacity data model contains a simple data mart and an advanced data mart.
•

Simple: Provides quick access to the most commonly used data elements. Includes only the last
snapshot of Data Warehouse data; it does not include historical data.

•

Advanced: Provides access to historical data values. All data elements in the Simple data mart are
also included in the Advanced data mart.

Qtree Capacity data
This data model enables you to trend qtree utilization (with data such as used compared to allocated
capacity) over time. You can also organize the information by different dimensions, for example, by
business entity, application, tier, and service level.
The fields and field descriptions are as follows:
Application
Application annotation associated with this qtree.
Business Unit
Business unit annotation associated with this qtree.
Internal Volume
Name of the internal volume on which the qtree resides.
Missing Quota Limits
Indication of a quota limit that is not set. If limits have been set,
“NO_LIMITS_MISSING” appears.
Protection Type
Type of protection used on the storage, for example, Mirrored or Striped.
Qtree
Name of qtree.
Service Level
Service level associated with the application.
Service Level Cost
Cost of providing the service or the actual price to service the consumer.
Storage
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Physical storage where the capacity resides.
Storage Access Type
Indication of the type of access to the storage, SAN or NAS.
Storage Pool
Name of the storage pool on which the qtree resides.
Tier
Level of service (for example, Gold, Silver, Bronze).
Tier Cost
Unit of cost per gigabyte assigned to the tier level.
Virtual Storage
The front-end array in case this qtree is on virtual internal volume.
Hard Limit Capacity
Disk space limit imposed on this qtree by a quota. If this is exceeded, data cannot be
written.
Soft Limit Capacity
Soft quota space limit that, if exceeded, issues warnings rather than rejects space requests.
Used Capacity
Capacity in the qtree including Snapshot Used Capacity. Used Capacity is no less than
Consumed Capacity, depending on the storage efficiency technology applied to this
resource.
See capacity concepts.
Qtree Capacity advanced data mart
The Advanced data mart contains the full table data structure, which contains all current and
historical data.
The Advanced data mart is organized into the following fact and dimension tables:
•

Qtree Capacity Fact table

•

<Time> Qtree Capacity Fact tables

•

Application Dimension

•

Business Entity Hierarchy

•

Date Dimension

•

Internal Volume Dimension

•

Qtree Dimension

•

Service Level Dimension

•

Storage Dimension

•

Storage Pool Dimension

•

Tier Dimension

•

Virtual Storage Dimension

Qtree Capacity data model fact table
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The Qtree Capacity Fact table shows information about the hard and soft limits on the qtree and
includes historical information.
Time Qtree Capacity Fact table
Use the elements in these tables to obtain historical data in your reports. The information in these
time period tables reflects a given time period only if the ETL runs in that period. For example, if
OnCommand Insight stops running for the entire month of February, there won't be a date point for
February.
The fact tables and table descriptions are as follows:
Current Qtree Capacity Fact
Qtree capacity fact data for only the last ETL run (the most recent date point).
Weekly Qtree Capacity Fact
Qtree capacity fact data for a single date point each week. Includes historical data.
Contains the values from the Qtree capacity table, filtered to include only values
associated with dates where the Is Week Representative equals 1.
Monthly Qtree Capacity Fact
Qtree capacity fact data for a single date point each month. Includes historical data.
Contains the values from the Qtree capacity table, filtered to include only values
associated with dates where the Is Month Representative equals 1.
Quarterly Qtree Capacity Fact
Qtree capacity fact data for a single date point each quarter. Includes historical data.
Q1 is Jan 1 - Mar 31
Q2 is Apr 1 - Jun 30
Q3 is Jul 1 - Sep 31
Q4 is Oct 1 - Dec 31
Storage and Storage Pool Capacity data model
The Storage and Storage Pool Capacity data model enables you to answer questions about storage
capacity resource planning including storage and storage pools, and includes both physical and
virtual storage pool data. This simple data model can help you answer questions related to capacity
on the floor and capacity usage of storage pools by tier and data center over time.
If you are new to capacity reporting, you should start with this data model, because it is a simpler,
targeted data model.
You can answer the following questions using the Storage and Storage Pool Capacity data model:
•

What is the projected date for reaching the capacity threshold of 80% of my physical storage?

•

What is the physical storage capacity on an array for a given tier?

•

What is my storage capacity by manufacturer and family as well as by data center?

•

What is the storage utilization trend on an array for all of the tiers?

•

What are my top 10 storage systems with the highest utilization?

•

What is the storage utilization trend the storage pools?

•

How much capacity is already allocated?

•

What capacity is available for allocation?
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Creating a sample report with the Storage and Storage Pool Capacity data model
This report shows the total used and raw capacity per storage pool.
About this task

The instructions provide steps to create the following report:

Steps

1. Access Query Studio.
For detailed steps, see the related links about accessing Query Studio.
2. Select Packages > Storage and Storage Pool Capacity.
3. From Query Studio, select Physical Capacity.
4. Select Storage > Storage Pool and insert it into the work area.
5. Select Capacity (MB) > Capacity and insert it into the work area.
6. Select Capacity (MB) > Raw Capacity and insert it into the work area.
7. Select Capacity (MB) > Used Capacity and insert it into the work area.
8. Select Capacity (MB) > Used Raw Capacity and insert it into the work area.
9. Optionally, group the report by Storage Pool by clicking the Storage Pool ID column and then the
Group icon in the upper right.
Storage and Storage Pool Capacity data model submarts
The Storage and Storage Pool Capacity data model includes two submarts.
•

All Capacity submart: Includes information about all storage pools, both physical and virtual. Use
this to answer questions about storage and storage pools, including virtual storage pools. This
submart excludes tier and data center to prevent double counting; however, this dimension itself
does not prevent double counting.

•

Physical Capacity submart: Includes information about only physical storage pools. Excludes
virtual storage pools. Use this submart if you want to report on tiers and data centers. This
submart itself does prevent double counting.

You can use only one submart per table or chart in a report. If you create a report that has multiple
tables or charts, both submarts still cannot be used for a single table or chart in that report.
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Projected capacity display in reports
You can show how much capacity will be used in a future by using the Projected Capacity data
elements, which are included in both the Physical Capacity and All Capacity submarts within the
Storage and Storage Pool Capacity data model.
Projected capacity is an indication of how much capacity will be used at a future date, based on a
linear regression algorithm that is applied to a set of recently observed capacity usage metrics.
The following example shows that if the capacity remains the same, you will run out of capacity
within the next twelve months:

Future Capacity (dark green dots)
Future Capacity in the system assuming that there is no addition of storage systems. This
corresponds to the capacity currently in the system.
Used Capacity (orange dots)
Used Capacity has been increasing.
Projected Used Capacity (light green dots)
According to the linear regression projection on the used capacity (orange dots), Projected
Used Capacity will reach Projected Capacity as shown in the top right where the dark
green and light green lines converge.
All Capacity submart details
You can use capacity data elements in the All Capacity submart in reports to show capacity
utilization. The All Capacity submart includes information about all storage pools, both physical and
virtual, but excludes tier and data center information.
Use this submart to answer these questions:
•

What are the top 10 highly utilized storage pools in the last quarter?

•

What is the storage pool capacity utilization over time?
Note: To report only on virtualized storage pools, you might want to filter using the Only Virtual
Storage Pools filter.

Several items denoted with a hierarchical icon include hierarchies of data. If you place one of these
items in your report, you will be able to drill down to its components.
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Date data elements
Use the date data elements to write different reports for different time frames. This is useful, for
example, when you want to view different time points in the past. The report using date data displays
a line for each time that the ETL ran.
For details about dates, see the full description of date information in the cross-reference links.
Only Virtual Storage Pools filter
Use this filter to display only those storage pools that are virtual. When array virtualization is in use,
the storage pool value reflects the storage pool from the front-end virtualizer.
Physical Capacity submart details
You can use capacity data elements in the Physical Capacity submart in reports to show capacity
utilization. This submart includes information about only physical storage pools and excludes virtual
storage pools. Use this submart to report by tier and data center.
Use this submart to answer these questions:
•

What is the raw capacity on the floor?

•

What is the capacity utilization over time, across data centers, or across tiers?

Several items denoted with an icon are hierarchical. If you place one of these items in your report,
you can drill down to its components.
VM Capacity data model
The VM Capacity data model enables you to report your virtual machine environment and its
capacity usage. This data model lets you report on changes in capacity usage over time for virtual
machines and data stores. The data model also provides thin provisioning and virtual machine
chargeback data.
The VM Capacity data model includes the following features:
•

Provides access to VM storage capacity information recorded in the OnCommand Insight Data
Warehouse.

•

Provides access to information about individual VMs, such as data store usage, guest OS, and
guest state.

•

Enables the creation of detailed capacity accountability (chargeback) reports on the VM,
application and business unit levels.

•

Maintains historical data to show trending data (last week. last month, last quarter, and so on).

You can answer the following types of questions using the VM Capacity data model:
•

How can I determine capacity chargeback based on capacity provisioned to VMs and data stores?

•

What capacity is not used by VMs and which portion of unused is free, orphaned, or other?

•

What do we need to purchase based on consumption trends?

•

What are my storage efficiency savings achieved by using storage thin provisioning and
deduplication technologies?
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Creating a sample report with the VM Capacity data model
You can create a report that shows the VM OS, its power state, VM count, and provisioned capacity.
About this task

This process can be used for any of the tables described in the VM Capacity data model.

Steps

1. Access Query Studio.
For detailed steps, see the related links about accessing Query Studio.
2. From a blank screen in Query Studio showing the VM Capacity data model, select the Advanced
Data Mart.
3. Select VM Dimension > VM OS and drag it into the work area.
4. Select VM Dimension > VM Power State and drag it to the right of the VM OS in the work
area.
5. Select VM Dimension > VM Count and drag it to the right of the VM Power State in the work
area.
6. To group the data by the power state, click on the VM Power State column in the work area and
click the Group icon.
7. Optionally, click Power State column and click the Pivot icon to create a crosstab format for the
report.
VM Capacity data model details
The VM Capacity data model contains a simple data mart and an advanced data mart.
•

Simple data mart

•

Advanced data mart

Capacities in the VM Capacity data model are taken from virtual disks (VMDKs). This means that
the provisioned size of a VM using the VM Capacity data model is the size of its virtual disks. This is
different from the provisioned capacity in the Virtual Machines view in the OnCommand Insight
Client, which shows the provisioned size for the VM itself.
VM Capacity data
This data model enables you to report your virtual machine environment and its capacity usage. This
data model lets you report on changes in capacity usage over time for virtual machines and data
stores.
The fields and field descriptions are as follows:
Actual Capacity
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The amount of data store capacity being used. This measurement ignores savings done in
the back-end storage using thin-provisioning and deduplication technologies.
See capacity concepts information in the cross references.
Application
Representative application.
Business Unit
The VM’s business unit or the business unit for the application.
Capacity Type
See capacity concepts information in the cross references.
Data Store
Data store name. If capacity has been associated with a virtual machine, then that capacity
has information about data stores to match. The virtual machine accesses the data store,
which is defined on the ESX hosts, and the hosts access the capacity.
Host
Representative host accessing the capacity.
Host Data Center
The physical location of the host resource where the capacity resides.
Moid
Managed object identification
Provisioned Capacity
The amount of capacity that was allocated for a VM. This measurement includes VMDKs
and other VM-related files.
See capacity concepts information in the cross references.
Service Level
Service level represents the agreement between a service consumer or application and the
storage service provider, associated with an application. Service level differs from tier.
For example, you might have multi-tiered storage pools including 1 FC pool and one SSD
pool. Your service level policy might require that Tier 1 should sustain 5,000 IOPS.
However, because this LUN uses only 100 IOPS, the service provider might decide to
move this service to a lower tier that sustains only 500 IOPS. The service level is 5,000 or
500 IOPS, while the tier represents the quality of service, for example, gold or silver.
Service Level Cost
Cost / GB is the cost per gigabyte for a service level.
The service level cost can be the cost of providing the service or the actual price to service
the consumer, while the tier cost is the average cost per GB for the specific tier.
Storage
Physical storage where the capacity resides.
Storage Access Type
Indication of the type of access to the storage, for example, SAN, NAS, or unknown.
Storage Data Center
Location of data center.
Tier
Level of service (for example, Gold, Silver, Bronze).
Tier Cost
Cost assigned to tier service per gigabyte.
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Virtual Center IP
IP is an attribute of a capacity fact. It is the IP of the virtual center instance that reported
this capacity. IP address of the Virtual Center for VM Capacity. Required because VM
Capacity types might have the VM dimension empty for the following Capacity Types:
data store Free, data store Overhead, and VM Volume Unused. See also VM Dimension in
the Reporting Glossary.
VM
Name of the virtual machine.
Note: Capacities not associated with hosts, applications, tiers, or VMs use “N/A” to
indicate null values.

VM IPs
IP of the VM.
VM OS
OS of the VM.
VM Power State
Indication of whether the VM power is on or off.
VM Capacity advanced data mart
The full table data structure is provided for the VM Capacity data model in the Advanced Data Mart,
which contains all current and historical data.
The Advanced data mart is organized into the following dimensions and attributes for capacity:
•

Current VM Capacity Fact table: Includes only the current VM Capacity values. This table is
used most often for writing reports that reflect the current state of the storage environment (as of
the last Data Warehouse build).

•

Application Dimension: A representative application from the group of applications using the
VM Capacity.

•

Application Group Dimension: Defines the application group (set of applications) that is using the
VM Capacity.

•

Business Entity Hierarchy: Includes the business entity elements in hierarchical order (tenant, line
of business, business unit, and project).

•

Capacity Type is an attribute of a capacity fact. See Capacity Types.

•

Date dimension: Includes dates and time periods from which you can select for the report. Each
capacity fact is associated with the date when the Data Warehouse build ran that generated the
fact.

•

Datastore dimension: defined as NAS, SAN, or UNKNOWN when the data store is not connected
a volume.

•

Host Dimension: A representative host from the group of hosts using the VM Capacity.

•

Host Group Dimension: Defines the host group (set of hosts) that is using the VM Capacity.

•

Internal Volume Dimension: Defines the internal volumes on which the capacity resides.

•

Service Level Dimension: Defines the storage service levels and costs.

•

Storage Dimension: Defines the physical storage from which the VM Capacity is taken.

•

Tier Dimension: Defines the tier based on the tier annotations in OnCommand Insight.
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•

Virtual Storage Dimension: Defines the front-end storage in configurations where capacity uses
storage virtualization.

•

VM Dimension: Defines the Virtual Machine using the capacity. The VM dimension table
provides a current (live) snapshot of inventory. If capacity is associated with a VM, the table
shows information about that VM.

•

VM Capacity Fact: Includes the full set of VM Capacity data for every Data Warehouse build
performed.

•

Time period fact tables: Provides historical data in your reports.
◦

Weekly VM Capacity Fact

◦

Monthly VM Capacity Fact

◦

Quarterly VM Capacity Fact

Current VM Capacity Fact
The Current VM Capacity Fact table contains the values from the VM Capacity Fact table filtered to
include only values associated with the Is Latest date (included in the Date Dimension table).
Use the VM Current Capacity Fact table to write reports that reflect only the latest data and not
historical data. (To include historical data, use the VM Capacity Fact elements.)
VM Capacity Fact
This fact table includes all VM Capacity fact data and includes a date point for each ETL process.
This table is useful for reporting on the data from a specific historical date, or providing more
detailed trending reports.
You might use this fact table less frequently than other tables. For descriptions see Current VM
Capacity Fact.
Volume Capacity data model
You can use this data model to analyze all aspects of volumes in your environment and look at them
by vendor, model, tier, service level, and data center. You can view capacity related to orphan
volumes, unused volumes, and protection volumes (used for replication). You can also see different
volume technology (iSCSI or FC) and compare virtual to non-virtual volumes for array virtualization
issues.
You can answer several types of questions using the Volume Capacity data model:
•

Which volumes have a utilization higher than a predefined threshold?

•

What is the trend in my data center for orphan volume capacity?

•

How much of my data center capacity is virtualized or thin provisioned?

•

How much of my data center capacity must be reserved for replication?

Creating a sample report with the Volume Capacity data model
This example displays all orphaned volumes in a specific storage system.
Steps

1. Access Query Studio.
For detailed steps, see the related links about accessing Query Studio.
2. From the blank screen in Query Studio showing the Volume Capacity data model, select All
Volumes.
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3. Select Storage > Storage Name and drag it into the work area.
4. Select Volume > Volume Name and drag it into the work area.
5. Select Capacity (GB) > Orphaned Volume Capacity (GB) and drag it into the work area.
6. Filter the report by orphaned volumes by selecting Filters > Include Only Orphaned Volumes
and dragging it into the work area.
7. Optionally, filter the report by a specific storage system by right-clicking on the storage system
column heading and selecting Filter.
Result

Volume Capacity data model details
This data model includes different submarts that enable you to include or exclude backend volumes.
This data model includes the following submarts:
•

Host Visible Volumes: Excludes backend volumes.

•

All Volumes: Includes backend volumes.

This data model includes the following data elements and dimensions:
•

Capacity

•

Data Center

•

Host

•

Service Level

•

Storage

•

Tier

•

Additional Summaries
You can add rows or columns to your report that are summarized by the following data:
Volume count
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The summary row displays the total number of volumes in the report.
Days since last access
The summary row displays the number of days since the resource was last accessed for
capacity requests.
This data model includes the following filters:
•

Include Only Accessed Volumes: Volumes that are accessed by hosts.

•

Include Only Orphaned Volumes: Volumes that are masked but do not have active paths to them.

•

Include Only Protection Volumes: Volumes that are used for replication.

•

Include Only Unused Volumes: Volumes that are not accessed by hosts.

•

Include Only Virtual Volumes: Volumes that are virtual.

Chargeback data model
The Chargeback data model enables you to answer questions about used capacity and allocated
capacity on storage resources (volumes, internal volumes, and qtrees). This data model provides
storage capacity chargeback and accountability information by hosts, application, and business
entities and includes both current and historical data. Report data can be categorized by service level
and storage tier.
Chargeback data is impacted by internal volumes:
•

For storage without internal volumes, chargeback reports show chargeback by volumes.

•

For storage with internal volumes:
◦

If business entities are assigned to volumes, chargeback reports show chargeback by volumes.

◦

If business entities are not assigned to volumes but assigned to qtrees, chargeback reports
show chargeback by qtrees.

◦

If business entities are not assigned to volumes and not assigned to qtrees, chargeback reports
show the internal volume.

◦

The decision whether to show chargeback by volume, qtree or internal volume is made per
each internal volume, so it is possible for different internal volumes in the same storage pool
to show chargeback at different level.

Capacity facts are purged after a default time interval. For details, see Data Warehouse processes.
Reports using the Chargeback data model might display different values than those reports using the
Storage Capacity data model.
•

For storage arrays that are not NetApp storage systems, the data from both data models is the
same.

•

For NetApp and Celerra storage systems, the Chargeback data model uses a single layer (of
volumes, internal volumes, or qtrees) to base its charges, while the Storage Capacity data model
uses multiple layers (of volumes and internal volumes) to base its charges.

You can answer the following types of questions using the Chargeback data model:
•

What is the used capacity for qtrees versus the limits set per application or business entity (tenant,
line of business, business unit, and project)?

•

What are the trends of our used and free capacity so that we can do capacity planning?

78 | OnCommand Insight Reporting Guide

•

How much should we charge back each business unit for its used capacity (based on qtrees and
visibility into internal values for NAS)?

•

Which application, business entity, or host consumes the most capacity?

Creating a sample report with the Chargeback data model
This example creates a report that shows qtree information, its provisioned capacity, and tier.
About this task

Steps

1. Access Query Studio.
For detailed steps, see the related links about accessing Query Studio.
2. From a blank screen in Query Studio showing the Chargeback data model, select Advanced Data
mart.
3. In the data model, expand Storage Dimension and select Storage and drag it in the work area.
4. Expand Host Dimension and select Host and drag it to the left of Storage in the work area.
5. Expand Application Dimension and select Application and drag it to the left of Host.
6. Expand Business Entity Hierarchy and select Business Unit and drag it to the left of
Application.
7. Expand Chargeback Fact and select Protection Type and Resource Type and drag each to the
right of Storage in the work area.
8. Expand Tier Dimension and select Tier and drag it to the right of Resource Type.
9. Optionally, group the report by Business Unit by clicking the Business Unit column and then the
Group icon in the upper right.
10. Optionally, pivot the report by clicking on the Tier column and then the Pivot icon in the upper
right.
11. Click on the Title and enter a report title.
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Chargeback data model details
The Chargeback data model contains a simple data mart and an advanced data mart.
•

Simple: Provides quick access to the most commonly used data elements. Includes only the last
snapshot of Data Warehouse data; it does not include historical data.

•

Advanced: Provides access to historical data values. All data elements in the Simple data mart are
also included in the Advanced data mart.

Chargeback data
This data model provides storage capacity chargeback and accountability information by hosts,
application, and business entities and includes both current and historical data. Report data can be
categorized by service level and storage tier.
The fields and field descriptions are as follows:
Application
Application annotation associated with this qtree.
Business Unit
Business unit annotation associated with this qtree.
Data Center
Location of data center, based on the switch’s data center annotation in OnCommand
Insight.
Host
Name of the host associated with the qtree.
Internal Volume
Name of the internal volume on which the qtree resides.
Mapped by VM
Indication whether this volume, qtree, or internal volume is used by a data store.
Protection Type
Type of protection used on the storage, for example, mirrored or striped.
Resource Name
Name of device or resource. In the Qtree data model, this is the qtree name. This can
appear as "N/A" for volumes or show the qtree name.
Resource Type
Type of device or resource, for example, host or qtree. In the Qtree data model, this type
shows as "QTREE."
Service Level
Service level represents the agreement between a service consumer or application and the
storage service provider, associated with an application. Service level differs from tier.
For example, you might have multi-tiered storage pools including one FC pool and one
SSD pool. Your service level policy might require that Tier 1 should sustain 5,000 IOPS.
However, because this LUN uses only 100 IOPS, the service provider might decide to
move this service to a lower tier that sustains only 500 IOPS. The service level is 5,000 or
500 IOPS, while the tier represents the quality of service, for example, gold or silver.
Service Level Cost
Cost / GB is the cost per gigabyte for a service level.
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The service level cost can be the cost of providing the service or the actual price to service
the consumer, while the tier cost is the average cost per GB for the specific tier.
Qtree
Name of the qtree.
Storage
Physical storage where the capacity resides.
Storage Access Type
Indication of the type of access to the storage, for example, SAN, NAS, or unknown.
Storage Pool
Name of the storage pool on which the qtree resides.
Tier
Level of service (for example, gold, silver, or bronze).
Tier Cost
Unit of cost per gigabyte assigned to the tier level.
Provisioned Capacity
Capacity promised to storage initiators. Often used for chargeback. See "Capacity
concepts" information.
Used Capacity
Capacity in the qtree including Snapshot Used Capacity. Used Capacity is no less than
Consumed Capacity, depending on the storage efficiency technology applied to this qtree.
See "Capacity concepts" information.
Chargeback advanced data mart
The Advanced data mart contains the full table data structure, which contains all current and
historical associations from hosts to applications (for example, multiple applications for each host or
hosts that are gone).
The Advanced data mart is organized into several fact and dimension tables.
Time Chargeback Fact table
Use the elements in these tables to obtain historical data in your reports.
The information in these time period tables reflects a given time period only if the ETL runs in that
period. For example, if OnCommand Insight stops running for the entire month of February, there
won't be a date point for the February table.
The fact tables and descriptions are as follows:
Current Chargeback Fact
Chargeback fact data for only the last ETL run (the most recent date point).
Weekly Chargeback Fact
Chargeback fact data for a single date point each week. Includes historical data. Contains
the values from the Chargeback table, filtered to include only values associated with dates
where the Is Week Representative equals 1.
Monthly Chargeback Fact
Chargeback fact data for a single date point each month. Includes historical data. Contains
the values from the Chargeback table, filtered to include only values associated with dates
where the Is Month Representative equals 1.
Quarterly Chargeback Fact
Chargeback fact data for a single date point each quarter. Includes historical data.
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Q1 is Jan 1 - Mar 31
Q2 is Apr 1 - Jun 30
Q3 is Jul 1 - Sep 31
Q4 is Oct 1 - Dec 31

Inventory data model
The Inventory data model lets you report on objects such as hosts, storage systems, switches, disks,
tapes, qtrees, quotas, virtual machines, servers, and generic devices. It includes several submarts that
enable you to see information about replications, FC paths, iSCSI paths, NFS paths, and violations. It
does not include historical data.
The Inventory data model includes the following features:
•

Provides easy access to most of the inventory information recorded in the OnCommand Insight
Data Warehouse.

•

Includes submarts that enable you to answer questions pertinent to an area of research.

•

Reflects the state of inventory at the time of the last Data Warehouse build.
The Inventory data model does not contain historical data.

•

Provides access to annotations, including user-defined annotations, set on objects in the storage
environment.

Using the Inventory data model, you can create reports that answer the following types of questions:
•

What assets do I have and where are they?

•

Who is using the assets?

•

What types of devices do I have and what are components of those devices?

•

How many hosts per OS do I have and how many ports exist on those hosts?

•

What storage arrays per vendor exist in each data center?

•

How many switches per vendor do I have in each data center?

•

How many ports are not licensed?

•

What vendor tapes are we using and how many ports exist on each tape?

•

Are all the generic devices identified before we begin working on reports?

•

What are the paths between hosts and storage volumes or tapes?

•

What are the paths between generic devices and storage volumes or tapes?

•

How many violations of each type do I have per data center?

•

For each replicated volume, what are the source and target volumes?

•

Do I have any firmware incompatibilities or port speed mismatches between Fibre Channel host
HBAs and switches?
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Creating a sample report with the Inventory data model
This example generates a report that answers the question: What types of violations occur per data
center?
About this task

This report includes both iSCSI and FC violations.

The following example shows the process, and it can be used for any table in the Inventory data
model.
Steps

1. Access Query Studio.
For detailed steps, see the related links about accessing Query Studio.
2. In Query Studio, expand the Inventory > Violation submart.
3. Expand the Violation > Simple data mart.
4. Select the Data Center element and drag it to the work area.
5. Select the Violation Type element and drag it into the work area to the right of the Data Center
column.
6. Select the Violation Count element and drag that into the work area to the right of Violation
Type.
The result is a report listing all violations and their types and count per data center location.
7. Optionally, to filter out any missing values or “N/A” values, click on the Data Center column
and click Filter. Exclude the "N/A" values.
8. To group the data, click on the Data Center column and click the Group icon.
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9. Optionally, click the Pivot icon to create a crosstab format for the report. The example in the
introduction of this section shows the pivoted report.
Inventory data model details
In the Inventory data model, the data is presented in various submarts. You can drag and drop
elements within one submart; you cannot combine elements from different submarts.
For example, the Inventory data model includes a Storage Asset submart and a Host submart. You
can drag and drop elements from the Storage Asset submart or from the Host submart, but not from
both submarts in the same report.
Each of the non-device specific submarts includes a Simple data mart.
Using submarts
Device submarts provide access to information about a particular type of device and the components
within that device, for example, all the volumes, shares, and ports on a storage array.
For definitions of each inventory element, see the Inventory chapter in OnCommand Insight
Inventory User Guide for the Java UI.
DR Replication submart
You can use the DR Replication submart to create reports on volume-to-volume replications. It
includes information about hosts accessing the source volumes and about hosts accessing the target
volumes. It also includes replicated count and volume capacity measurements.
Using this submart, you can answer the following questions:
•

Which volumes are being replicated and on which hosts?

•

For each replicated volume, what are the source and target volumes?

FC Path submart
You can use the FC Path submart to create reports on Fibre Channel paths between hosts and storage
volumes or tapes and paths between generic devices and volumes or tapes.
Using this submart, you can answer the following questions:
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•

What is the path between hosts and volumes?

•

Are there redundant paths for critical storage needs?

•

What is the volume capacity related to this path?

Generic Device Assets submart
You can use the Generic Device Assets submart to create reports on generic devices and their ports.
Using this submart, you can answer the following questions:
•

How many generic devices exist in the environment?

•

Should we perform more identifications before we rely on incomplete report data?

Host Assets submarts
You can use the Host Assets submart to create reports on hosts and their adapters, ports, and
annotations.
Using this submart, you can answer the following questions:
•

How many hosts per OS do I have?

•

How many ports exist on each host?

Host Port Connectivity submart
You can use the Host Port Connectivity submart to create reports on the connectivity between host
and switch FC ports.
Using this submart, you can answer the following questions:
•

Do I have firmware incompatibilities between Fibre Channel host HBAs and switches?

•

Do I have port speed mismatches between Fibre Channel host HBAs and switches?

iSCSI Path submart
You can use the iSCSI Path submart to create reports on iSCSI paths between hosts and storage
volumes.
Using this submart, you can answer the following questions:
•

What is the SAN path for iSCSI?

•

What are the session and connection counts on paths for critical storage needs?

•

What is the volume capacity related to this path?

NFS Path submart
You can use the NFS Path submart to create reports on NFS paths to show services or end points of
NAS paths to NFS Exports.
Using this submart, you can answer the following questions:
•

What shares are exported from storage?

•

Which initiator hosts are accessing those shares?

Storage Assets submart
You can use the Storage Assets submart to create reports on storage arrays and their volumes, storage
pools, internal volumes, shares, disks, qtrees, quotas, controllers, and FC ports.
Using this submart, you can answer the following questions:

Creating custom ad hoc reports | 85

•

How many storage arrays per OS do I have in each data center?

•

What is the available and used capacity of the volumes, internal volumes, and storage pools?

•

What storage arrays per vender exist in each data center?

•

What is the hard capacity quota set on qtrees per storage system?

Switch Assets submart
You can use the Switch Assets submart to create reports on switches and their fabrics, ports, and
annotations.
Using this submart, you can answer the following questions:
•

How many switches per vendor do I have?

•

Are there any nonlicensed ports in each data center? If so, how many?

Tape Assets submart
Using the Tape Assets submart you can create reports on tapes and their controllers, ports and
annotations.
Using this submart, you can answer the following questions:
•

How many tapes per vendor do I have?

•

How many ports are associated with each tape?

Violation submart
You can use the Violation submart to create reports on OnCommand Insight violations between hosts
and storage volumes or tapes. Create reports on violations between generic devices and storage
volumes or tapes.
Using this submart, you can answer the following questions:
•

What are the types of violations of each type per data center?

•

What is the volume capacity related to the violations per data center?

Performance data models
The Performance data models enable you to answer questions about performance for volumes,
internal volumes, applications, switches, and hosts.
The Performance data models include information that helps you determine appropriateness of tiers,
storage misconfigurations for applications, traffic data through the switches, and volume and internal
volume last access times. This data model provides data such as response times, IOPs, throughput,
number of writes pending, and accessed status.
Performance information is provided in the separate Performance data models.
Using the Performance data model, you can create reports that answer the following types of
questions:
•

What volumes or internal volumes have not been used or accessed during a specific period?

•

Can we pinpoint any potential misconfiguration for storage for an application (unused)?

•

What was the overall access behavior pattern for an application?

•

Are tiered volumes assigned appropriately for a given application?
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•

Could we use less expensive storage for an application currently running without impact to
application performance?

•

What are the applications that are producing more accesses to currently configured storage?

•

Is my host traffic through connected ports balanced?

•

What are the most used switches based on port performance?

•

What is the host trending throughput based on port performance?

•

Which devices are producing traffic on a specific switch (for example, which devices are
responsible for use of a highly utilized switch)?

Creating a sample report with one of the Performance data models
You can access the data model and create a sample report. This example generates a report that
answers the question: Are there any misalignments having a maximum IOPS of less than 100 or
maximum throughput of less than 100?
About this task

You cannot drag elements from different data models into the same report.

Steps

1. Access Query Studio.
For detailed steps, see the related links about accessing Query Studio.
2. In OnCommand Insight Reporting, in the Public Folders, click the Packages folder link.
3. In the Packages folder, click the Volume Daily Performance link.
4. Expand the Data mart.
5. Expand the Application Dimension, select the Application Name element, and drag that into the
work area.
6. Expand Volume Daily Performance Fact.
a. Select the Max Total IOPS element and insert it into the work area.
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b. Select the Max Total Throughput element and insert it to the work area.
The result is a table listing all applications and their maximum total IOPS and total throughput.
However, you want to limit your results to those with maximum IOPS of less than 100 or
maximum throughput less than 100.
7. Right-click the Max Total Throughput column and select Filter. Enter the range of 0 to 100.
8. Right-click the Max Total IOPS column and select Filter. Enter the range of 0 to 100.
9. Expand the Business Entity Dimension, select the Business Unit element and drag it into the
work area to the left of the Application Name.
10. Optionally, to filter out any missing values or “N/A” values, click the Application column, rightclick and select Filter. Select the applications you want to include.
11. To group the data, click on the Business Unit column and click the Group icon.
Performance data model details
Various models are included in the Performance data models.
All throughput measurements are in megabytes per second.
Combining related data models
You can drag and drop elements within one Performance data model; you cannot combine elements
from different Performance data models.
For example, the Performance data model includes a Volumes Daily submart and an Internal Volumes
Daily submart. You can drag and drop elements from the Volumes Daily submart or from the Internal
Volumes Daily submart, but not from both submarts in the same report.
Application Volume Hourly Performance data model
This data model provides application performance data extracted from volume hourly data.
The data model contains the following fact and dimension tables:
•

Application Volume Hourly Dimension

•

Business Entity Hierarchy

•

Date Dimension: Includes dates and time periods from which you can select for the report. Each
fact is associated with the date when samples were taken into the system, not the time when Data
Warehouse was processed.

•

Service Level Dimension

•

Tier Dimension

•

Time Dimension

•

Virtual Storage Dimension

•

Time Facts: You can use Last Week, Last Month, and Last Quarter to filter different time periods.

•

Application Volume Hourly Performance Fact: This table displays the response time, IOPS,
throughput, and cache hit ratio information.
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Host Volume Hourly Performance data model
This data model provides host performance data, which was extracted from volume hourly data.
There are Simple and Advanced data marts.
The data model contains the following fact and dimension tables.
•

Business Entity Hierarchy

•

Date Dimension: Includes dates and time periods from which you can select for the report. Each
performance fact is associated with the date when the data was sampled.

•

Host Dimension: A representative host from the group of hosts.

•

Service Level Dimension

•

Tier Dimension

•

Time Dimension

•

Host Performance Fact

•

Time Facts

Internal Volume Daily Performance and Internal Volume Hourly Performance data models
This data model provides internal volume performance data, which was extracted from either internal
volume daily or hourly data.
The data model contains the following fact and dimension tables:
•

Application Dimension

•

Business Entity Hierarchy

•

Date Dimension: Includes dates and time periods from which you can select for the report. Each
performance fact is associated with the date when the data was sampled.

•

Internal Volume Dimension: A representative internal volume from the group of internal volumes.

•

Service Level Dimension

•

Storage Dimension

•

Storage Pool Dimension

•

Tier Dimension

•

Time facts: You can use Last Week, Last Month, and Last Quarter to filter different time periods.

•

Internal Volume Daily/Hourly Performance Fact: From this, you can include IOPS, throughput,
response time, and accessed information.

Switch Performance data model
The Switch Performance data model enables you to answer questions about host traffic, underutilized and over-utilized switches, and throughput.
You can answer the following types of questions using the Switch Performance data model:
•

Is my host traffic through connected ports balanced?

•

Show me switches/ports exhibiting a high number of errors.

•

Show me most used switches based on port performance.
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•

Show me underutilized switches based on port performance.

•

Show me host trending throughput based on port performance.

•

Show me performance utilization for last X days for one specified host, storage system, tape, or
switch.

•

Show me which devices are producing traffic on a specific switch (for example, which devices are
responsible for use of a highly utilized switch).

•

Show me throughput for a specific business unit in our environment.

The data model includes the following fact and dimension tables:
•

Application

•

Business Entity Dimension

•

Connected Device Dimension

•

Data Center Dimension

•

Fabric Dimension

•

Host Dimension

•

Storage Dimension

•

Switch Port Dimension

•

Tape Dimension

•

Time Dimension

•

Hourly Performance for Host

•

Hourly Performance for Storage

•

Hourly Performance for Switch Port

•

Hourly Performance for Tape

Switch Performance fact tables
The Switch Performance data model includes switch performance fact tables for hosts, ports, storage
systems, and tapes.
The following fact tables are included:
Hourly Performance for Host
Contains hourly rollups of port performance data aggregated per host. Each line represents
one hour of port performance for ports connected to a specific host.
Hourly Performance for Switch Port
Contains hourly rollups of port performance per switch port. Each line represents one hour
of port performance for one port within a switch.
Hourly Performance for Storage
Contains hourly rollups of port performance data aggregated per storage. Each line
represents one hour of port performance for ports connected to a specific storage.
Hourly Performance for Tape
Contains hourly rollups of port performance data aggregated per tape. Each line represents
one hour of port performance for ports connected to a specific tape.
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Volume Daily Performance and Volume Hourly Performance data models
This data model provides daily and hourly aggregated data for volume performance.
The data model contains the following face and dimension tables:
•

Application Dimension

•

Application Group Dimension

•

Business Entity Hierarchy Dimension

•

Date Dimension: Includes dates and time periods from which you can select for the report. Each
performance fact is associated with the date when the data was sampled.

•

Host Dimension

•

Host Group Dimension

•

Service Level Dimension

•

Storage Dimension

•

Storage Pool Dimension

•

Tier Dimension

•

Time Facts: You can use Last Week, Last Month, and Last Quarter to filter different time periods.

•

Virtual Storage Dimension

•

Volume Dimension

•

Volume Daily or Hourly Performance Fact: Displays the response time, IOPS, throughput, and
cache hit ratio information.

Storage Efficiency data model
The Storage Efficiency data model enables you to track the storage efficiency score and potential
over time. This data model stores measurements of not only the provisioned capacity, but also the
amount used or consumed (the physical measurement). For example, when thin provisioning is
enabled, OnCommand Insight indicates how much capacity is actually taken from the device. Use
this model also to determine efficiency when deduplication is enabled.
You can review storage by name, model, manufacturer, family, and data center. You can also review
raw capacity, backend capacity, gain/loss, and potential gain/loss.
You can answer the following types of questions using the Storage Efficiency data model:
•

What does the implementation of thin provisioning and deduplication technologies yield in
storage efficiency savings?

•

What are the storage savings across data centers?

•

What is the historical trend of disk-based storage for the last three quarters?

•

Based on actual utilization data, are we using the disk resources we have efficiently?

•

Based on historical capacity trends, when do we need to purchase additional storage?

•

What would be the capacity gain if we enabled technologies such as thin provisioning and
deduplication?

•

Am I at risk of running low on storage capacity now?
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Storage Efficiency data model concepts
Different storage technologies can yield increases (gains) or decreases (losses) to capacity. This table
describes some of these technologies and indicates whether the technology represents a gain or a loss
to capacity.
Storage Technology

Gain or Loss

Notes

Disk failure protection

Loss

Represents the amount of capacity that is used to
protect disk groups by RAID level.
Example: RAID-4 where a single disk that is using
every disk group for parity. Summing the size of the
parity disk generates capacity loss.

Deduplication

Gain

Represents data compression or saved capacity in a
compression ratio.
Example: In a 2:1 compression ratio, for every 1 GB
compressed capacity, there should be 2 GB of
uncompressed capacity. This means that more space
is needed to store the same data without
deduplication.

Thin provisioning

Gain

Helps to eliminate over provisioning by consuming
capacity only from the capacity that is used by the
volume.

Clones

Gain

The clone shares capacity with its source volume and
consumes only the capacity that is not mutual to itself
and the source volume.

Storage efficiency calculation
Storage efficiency is calculated with a specific mathematical formula.
The efficiency of storage is calculated by taking the total storage raw capacity and adding the gainers,
then subtracting the consumers. Finally, divide the total by the total storage raw capacity as follows:

Creating a sample report with the Storage Efficiency data model
This example creates a sample report showing storage efficiency per data center and manufacturing
vendor.
About this task
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Steps

1. Access Query Studio.
For detailed steps, see the related links about accessing Query Studio.
2. From a blank screen in Query Studio showing the Storage Efficiency data model, select
Advanced Data Mart.
3. Expand Storage Dimension.
4. Select and drag Data Center, Manufacturer, Model, and Storage Name into the work area.
5. Expand Efficiency Fact.
6. Select and drag Storage Technology, Raw Capacity, Potential Gain, and Potential Loss into
the work area.
7. Optionally, group the report by data center by clicking the Data Center column and then the
Group icon in the upper right.
8. Optionally, group the report next by Manufacturer.
Storage Efficiency data model details
The Storage Efficiency data model contains a simple data mart and an advanced data mart.
•

Simple: Provides quick access to the most commonly used data elements. Includes only the last
snapshot of Data Warehouse data; it does not include historical data.

•

Advanced: Provides access to historical data values. All data elements in the Simple data mart are
also included in the Advanced data mart.

Storage Efficiency data
This data model enables you to track the storage efficiency score and potential over time. This data
model stores measurements of not only the provisioned capacity, but also the amount used or
consumed (the physical measurement).
The fields and field descriptions are as follows:
Backend Capacity
Total capacity of backend LUNs. Relevant for virtual arrays only.
Data Center
The physical location of the storage device where the capacity resides.
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Gain/Loss in MB
Capacity gained or lost by using the technology. “0” appears when the technology is not
specified.
See Storage Efficiency concepts in the cross references.
IP
IP address assigned to the storage array.
Manufacturer
Name of the manufacturer of the storage array.
Microcode Version
Version of the firmware running on the storage array.
Model
Manufacturer’s model number.
Potential Gain/Loss in MB
Potential capacity to gain or lose by using the technology to the full extent. “0” appears
the when technology is not specified.
Raw Capacity
See capacity concepts in cross references.
Serial Number
Serial number for the storage array.
Storage Family
Product classification of the storage array (for example, CLARiiON or Symmetrix).
Storage Name
Name of the storage where the capacity resides.
Technology
Storage efficiency and protection technology such as deduplication, thin provisioning, or
type of protection used on the storage, for example, mirrored or striped. Blank when
representing the storage's raw and backend capacity (one row storage).
Storage Efficiency advanced data mart
The Advanced data mart contains the full table data structure, which contains all current and
historical associations from hosts to applications (for example, multiple applications for each host,
hosts that are gone).
The Advanced data mart is organized into the following fact and dimension tables:
•

Date Dimension: Includes dates and time periods from which you can select for the report. Each
capacity fact is associated with the date when the Data Warehouse build ran that generated the
fact.

•

Efficiency fact: Includes the capacity data.

•

Storage Dimension: Provides attributes (such as storage name, IP, model, manufacturer, family,
and type). Also includes data center.
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Efficiency Fact
This fact table includes all capacity efficiency fact data and includes a date point for each ETL
process. You might use this fact table less frequently than other tables. This table is useful for
reporting on the data from a specific historical date, or providing more detailed trending reports.
Time Efficiency Fact table
Use the elements in these tables to obtain historical data in your reports.
The information in these time period tables reflects a given time period only if the ETL runs in that
period. For example, if OnCommand Insight stops running for the entire month of February, there
won't be a date point for February.
The fact tables and descriptions are as follows:
Current Efficiency Fact
Efficiency fact data for only the last ETL run (the most recent date point).
Weekly Efficiency Fact
Efficiency fact data for a single date point each week. Includes historical data. Contains
the values from the Efficiency table, filtered to include only values associated with dates
where the Is Week Representative equals 1.
Monthly Efficiency Fact
Efficiency fact data for a single date point each month. Includes historical data. Contains
the values from the Efficiency table, filtered to include only values associated with dates
where the Is Month Representative equals 1.
Quarterly Efficiency Fact
Efficiency fact data for a single date point each quarter. Includes historical data.
Q1 is Jan 1 - Mar 31
Q2 is Apr 1 - Jun 30
Q3 is Jul 1 - Sep 31
Q4 is Oct 1 - Dec 31
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How to send comments about documentation and
receive update notifications
You can help us to improve the quality of our documentation by sending us your feedback. You can
receive automatic notification when production-level (GA/FCS) documentation is initially released or
important changes are made to existing production-level documents.
If you have suggestions for improving this document, send us your comments by email.

doccomments@netapp.com
To help us direct your comments to the correct division, include in the subject line the product name,
version, and operating system.
If you want to be notified automatically when production-level documentation is released or
important changes are made to existing production-level documents, follow Twitter account
@NetAppDoc.
You can also contact us in the following ways:
•

NetApp, Inc., 495 East Java Drive, Sunnyvale, CA 94089 U.S.

•

Telephone: +1 (408) 822-6000

•

Fax: +1 (408) 822-4501

•

Support telephone: +1 (888) 463-8277
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